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Getting Help
Use the Dashboard Help button to find the help you need. You can also look in the Dashboard readme file
README.WRI for information about some problems that may occur while you are using Dashboard. 

Index Help
1. Double-click the Help button to see an index of help topics.

2. Click Introducing Dashboard to see a brief explanation of Dashboard.

3. Click a topic from the How To list to see instructions for that task.

Context Help
1. Click the Help button and the cursor becomes a question mark.

2. Put the question mark on any item on Dashboard and click there to see specific help for that item.



Introducing Dashboard
Dashboard for Windows is the convenient push-button utility which gives you quick access to and 
maximum control over your Windows programs.

Dashboard includes these features (and many more):

n Convenient menus and buttons for launching programs.

n Drag-and-drop support for launching programs and for printing, plotting, and faxing files.

n Miniature "extended screens" that make it easy to work with several full-screen programs at 
once.

n A clock and calendar with a built-in snooze alarm.

n "At a glance" feedback about the available levels of memory and System Resources.

n User-defined "Hotkeys" and mouse buttons.

n "Sticky Apps"User-selected programs that remain displayed as you switch among Dashboard's
extended screens.

n Snap-off toolbars for frequently used Dashboard panels.

n Horizontal and vertical orientation of Dashboard.

n Disk space monitoring with the Drive Watch panel.

n Convenient vertical and horizontal sizing of the Dashboard window.

n Font and color choices for the Dashboard window.

n A layout feature that lets you save your own application arrangement and launch that 
arrangement when you start Dashboard.
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Checking Your Resources
You can use the Resource Gauge and the Memory Odometer to check the levels of total free memory 
and Windows System Resources on your system.    You can use the Drive Watch panel to check the 
disk space levels on any of your computer's drives.

The Resource Gauge shows the level of Windows System Resources currently available on your system. 

Each application you open uses System Resources memory.    If the level of System Resources gets too 
low, you may not be able to open new applications. The Warning Indicator blinks and sounds an alarm as 
you reach the alarm level for either available free system memory or system resources. You can double-
click the Resource Gauge to see a list of all applications currently running on your system; if you need 
more memory or resources, close one or more of these applications.

The Memory Odometer shows the total amount of free system memory in kilobytes. You can configure the
Resource Gauge to show or hide the Memory Odometer. You can also display the Resource gauge as a 
fuel gauge or a bar gauge. 

The Drive Watch panel shows the current amount of space for each drive on your system. You can add or
remove drives from the panel.

You can see more detailed information about your resources and memory by double-clicking the 
Resource Gauge or Drive Watch panel on Dashboard.

See Also
The Resources Dialog Box
Resources Main Preferences 
Resources Drive Watch Preferences



Customizing the Program Menu
The Program Menu displays a list of program groups you can work with from Dashboard. These groups 
are the same as those you see in the Program Manager. You can make changes to these groups and to 
the Program Menu itself from the Dashboard window or in the Customize dialog box. You can modify, 
add, delete, and hide groups using Dashboard and change the order of the Program Menu buttons. 

When you modify program groups or add a new group in Program Manager, these changes will not be 
reflected in the Dashboard groups until you click the Reread from Program Manager button in the 
Program Menu Preferences.    If you close Dashboard and then run it again, the changes will also take 
effect.

Modifying the Program Menu in the Customize dialog box
1. Double-click the right mouse button on one of the Program Menu buttons to open the Customize 

dialog box with Program Menu Preferences.

If the Program Menu is not currently displayed on Dashboard, click the Customize button and then 
click Program Menu in the list.

2. To make a change to a program group, click on that program group in the list, and then click one of 
the following buttons to choose which task you want to perform on the selected program group.

n Choose Modify to change the color of the key on the program group button, or enter a new 
description for the program group.

n Choose Open to open the program group.

n Choose Delete to delete the program group from Dashboard and the Program Manager.

n Choose New to create a new program group.

3. To change the position of a program group on Dashboard, drag the group to a new position in the list. 
The position of the program group's button on Dashboard is changed appropriately.

4. To hide a group on the Program Menu, click on the group in the list and click Hide Group.    

If you want to show the group again, click on the group and click Show Group.

5. Choose the Show 2nd row of text option if you want the Program Menu buttons to be full size. If this 
option is not checked, the buttons will show only a single row of text.

6. Choose the Show Color Keys option if you want color keys for each program group to be displayed in 
the Program Menu.

7. To update Dashboard with changes made using the Program Manager, click the Reread from 
Program Manager button.

Creating a Program Menu toolbar
1. Click the Customize button.

2. In Dashboard Preferences, click the Toolbars tab.

3. Choose the Program Menu option.

4. If you want the toolbar to minimize when you minimize Dashboard, choose the Toolbars minimize with
Dash option.

5. Click Done.

The Program Menu toolbar panel is now displayed on Dashboard.

6. Click the Program Menu panel. 

The Program Menu toolbar opens.

If you want to resize the toolbar, drag any of the toolbar borders in the appropriate direction.



Rearranging the Program Menu by Dragging
n In the Dashboard window, drag the Program Menu button you want to move to a new position on the 

Program Menu.

Resizing the Program Menu in Dashboard's Vertical Orientation
When you are running Dashboard in the Vertical Orientation, you can change the size of the Program 
Menu by dragging its borders.

1. Hold down the Shift key and place the cursor over the top or bottom border of the Program Menu 
panel.

The cursor changes to a two-headed arrow.

2. Press the mouse button over a border.

A dark gray box appears over the Program Manager borders.

3. Drag the Program Menu border until the Program Menu panel is the size you want.

See Also
Managing Program Groups with the Program Menu
Managing Program Groups with Program Windows
Using Custom Dashboard Configurations
Using Toolbars



Customizing Quick Launch Buttons
Use Quick Launch buttons on Dashboard to launch any program directly from Dashboard with a single 
click. You can create a Quick Launch button by dragging a program to the Quick Launch panel or by 
setting options in the Customize dialog box.

You can view the path and name of an application by clicking the right mouse button on the applications 
Quick Launch button, either in the Dashboard window or on the toolbar.    A pop-up box opens, displaying 
the applications path and name.

Creating a Quick Launch button by dragging a program
Drag the program to the Quick Launch panel.    You can drag a program from the File Manager, the 
Program Menu or Program Menu toolbar, a program window, or the Command Prompt in the Dashboard 
Run dialog box. If you want to customize the new Quick Launch button, you can set options for it in the 
Customize dialog box.

Creating a Quick Launch button with the Customize dialog box
1. Double-click the right mouse button on one of the Quick Launch buttons to open the Customize dialog

box with Quick Launch Preferences.

If the Quick Launch panel is not currently displayed on Dashboard, click the Customize button and 
then click Quick Launch in the list.

2. Click New.

3. Enter a title for the button.

4. Enter the correct command line (path name and file name) and working directory for the program. 

If you don't know the path name for the program, click Browse.

5. Enter a shortcut key if you want to use the keyboard to start the program or bring it's window to the 
front of any other open windows.    

To enter a shortcut key, click in the Shortcut Key box and press the key combination you wish to set.

You can enter a function key (for example, F4) or a number, letter, or character key. If you enter any 
key other than a function key, Dashboard inserts the Ctrl and Alt keys in front of your key. 

If you want to clear the existing shortcut key, click in the Shortcut Key box and press Del or 
Backspace.

If you use this shortcut key when you have a full-screen DOS application running, Dashboard will not 
launch the application associated with the shortcut key.    If the application is already running, 
Dashboard will bring the window to the front of the desktop.

6. Choose the Run Minimized option if you want the program to be minimized when you open it.

7. If the program includes an icon file, its icon appears on the Quick Launch button.    If the program 
does not have an icon, Dashboard will display a default icon.    Click Change Icon to change the 
displayed icon.

8. Choose one of the three available styles for the button.

n Choose Unlabeled to display only icons on the buttons.

n Choose Labeled to display icons and application names on the buttons.

n Choose Mini to display miniature buttons with icons. 

9. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

Rearranging Quick Launch buttons by dragging



n In the Dashboard window, drag the Quick Launch button you want to move to a new position on the 
Quick Launch panel.

Rearranging Quick Launch buttons with the Customize dialog box 
1. Double-click the right mouse button on one of the Quick Launch buttons to open the Customize dialog

box with Quick Launch Preferences.

2. In the Quick Launch button list, drag the program you want to move to a new position.

Creating a Quick Launch toolbar 
1. Click the Customize button.

2. In Dashboard Preferences, click the Toolbars tab.

3. Choose the Quick Launch option.

4. If you want the toolbar to minimize when you minimize Dashboard, choose the Toolbars minimize with
Dash option.

5. Click Done.

The Quick Launch toolbar panel is now displayed on Dashboard.

6. Click the Quick Launch panel. 

The Quick Launch toolbar opens.

See Also
Launching Programs by Dragging
Quick Launch Preferences
Using Custom Dashboard Configurations
Using Toolbars



Customizing the Alarm Clock
The alarm clock displays the date and time as set on your computer. To reset the date and time, use the 
Windows Control Panel.

You can customize the alarm clock to change its appearance and to set the interval for the snooze button.

1. Double-click the right mouse button on the clock or calendar to open the Customize dialog box with 
the Clock/Calendar Preferences.

If the Clock or Calendar is not currently displayed on Dashboard, click the Customize button and then 
click Clock/Calendar in the list.

2. Click a Clock Type option. Analog clocks show time with minute and second hands pointing to 
numbers, and digital clocks represent time as a number.

3. Click to open the Clock Face drop-down list, and choose an option to specify the appearance of the 
clock you want.

4. Choose the Second Hand option to show or hide the second hand on the analog clock.

The second hand may interfere with some communication programs.    If your communication 
program is experiencing unnecessary time-outs, try turning off the Second Hand option.

5. Next to Snooze Interval, type the number of minutes in which you want the alarm to reappear after 
you click the Snooze button in an alarm message.

6. Click Alarms to set an alarm.

If you did not install the Sound Driver for PC-Speaker during the Dashboard installation procedure, 
you cannot hear sound with the alarm.    For instructions on installing the driver, see your Dashboard 
Owner's Handbook.

7. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

See Also
Clock Preferences
Customizing the Calendar
Setting an Alarm
Using Custom Dashboard Configurations



Customizing the Printer Manager
You can customize Dashboard's Printer Manager to choose which print devices (printers, plotters, and fax
machines) you want to appear in Dashboard, the order in which they appear, and which printer should be 
the default printer. You can also specify the icons and descriptions for each printer.

Modifying the Printer Manager
1. Double-click the right mouse button on one of the printer icons to open the Customize dialog box with 

the Printer Manager Preferences.

If the Printer Manager is not currently displayed on Dashboard, click the Customize button and then 
click Printer Manager in the list.

2. Choose the Show Paper Orientation option if you want each printer icon to display the paper 
orientation for that printer.

3. Select a printer device you want to work with from the list on the right.

4. Use the Hide Printer and Show Printer buttons to choose whether the selected device should appear 
in Dashboard.

5. The order in which printer devices are listed indicates the order in which they will appear, left-to-right, 
in Dashboard. To move a printer to its new position on Dashboard, click it in the list and drag it to its 
new position in the list.

6. Use the Description text area to enter a title for the selected printer.    This title will appear on the 
printer icon in Dashboard.

7. Click the Change Icon button to change the displayed icon for the device.

8. Click the Set As Default button to select a default device.

9. Click the Setup button to display the Printer Configuration dialog box for the selected printer. Refer to 
Windows or your printer documentation for more information.

10. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

Rearranging printers by dragging
n In the Dashboard window, drag the Printer button you want to move to a new position on the Quick 

Launch panel.

Installing a new printer, plotter, or fax machine
Dashboard's Printer Manager includes devices that have been installed in Windows. To install new 
devices, use the Windows Control Panel.

Creating a Printer Manager toolbar 
1. Click the Customize button.

2. In Dashboard Preferences, click the Toolbars tab.

3. Choose the Printer Manager option.

4. If you want the toolbar to minimize when you minimize Dashboard, choose the Toolbars minimize with
Dash option.

5. Click Done.

The Printer Manager toolbar panel is now displayed on Dashboard.

6. Click the Printer Manager panel.



The Printer Manager toolbar opens.

See Also
Printer Manager Preferences
Using Custom Dashboard Configurations
Using Toolbars



Customizing Resources
You can modify the appearance of the Resource Gauge and the Drive Watch panel from the Customize 
dialog box.    You can view information about your Windows System Resources and total free 
memory, as well as data about all your drives, and you can set alarms to warn you about low memory on
your system.

The options for customizing resources are divided into two cards in the Resources Preferences. For 
instructions on using these options, click on one of the following procedures:

Setting Main Preferences for Resources 
Setting Drive Watch Preferences for Resources 



Customizing Extended Screens
You can customize Dashboard's extended screens by specifying the size and appearance of the screens, 
as well as the number of screens to be displayed. You can create hotkeys that let you use the keyboard to
move among the screens.    You can also designate certain programs as "Sticky Apps."    These programs 
remain displayed even when you switch from one extended screen to another.

The options for customizing the extended screens are divided into three cards in the Extended Screens 
Preferences. For instructions on using these options, click on one of the following procedures:

Setting Main Preferences for Extended Screens
Setting Hotkeys Preferences for Extended Screens
Setting Sticky Apps Preferences for Extended Screens



Rearranging Items on Dashboard
You can rearrange items on Dashboard using the Customize dialog box as well as directly in the 
Dashboard window.

Rearranging panels from the Customize dialog box
1. Click the Customize button.

2. Drag the item you want to move in the list to a new position in the list.    As you drag the item, the 
cursor changes to a two-headed arrow.

In Dashboard's horizontal orientation, the top-to-bottom sequence in the list corresponds to how items
are arranged from left to right on Dashboard. For example, if you want the clock to be on the far right, 
drag it to the bottom of the list.

In Dashboard's vertical orientation, the top-to-bottom sequence in the list corresponds to how items 
are arranged from top to bottom on Dashboard.    For example, if you want the clock to be at the top of
Dashboard, drag it to the top of the list.

3. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

Rearranging buttons on a Dashboard panel
You can rearrange the buttons on certain Dashboard panels and toolbars by dragging.    You can move a 
Quick Launch button, a Program Menu button, or a Printer Manager button by dragging the button to a 
new position in its panel. 

See Also
Dashboard Panels
Moving and Resizing Dashboard
Using Custom Dashboard Configurations



Using Custom Dashboard Configurations
1. Make all the changes you want in the Customize dialog box. 

2. Choose Save or Save As from the File Menu.

Save saves the current configuration into the configuration file currently being used.    The caption of 
the Customize dialog box shows the name of the current file.    Use Save As to save to a different file 
name.

3. In the Save As dialog box, enter the path and file name for the file in the edit box.    A .cfg extension is 
automatically added to the new file name and the current configuration file now changes to the new 
file name.

4. Click OK, then click Done in the Customize dialog box.

If you don't want to keep the changes, click Undo.

See Also
The Customize Dialog Box



Setting an Alarm
You can use Dashboard's clock and calendar to set alarms to display a message, set off an alarm sound, 
or launch a program automatically.    If you want to set an alarm for the current day, you can use the clock. 
If you want to set an alarm for a day other than the current day, you can use the calendar.    You can set 
an alarm to go off on a recurring basis or for one time only.

1. Double-click the Clock or the Calendar on Dashboard.

2. In the Clock Alarms dialog box, click the Add button.

If you double-clicked the Clock, the date in the Clock Alarms dialog box is automatically set to the 
current date.    If you double-clicked the Calendar, the date in the dialog box is automatically set to the
date you double-clicked.

3. Specify a time for the alarm.

Enter the hour and minutes or click the up and down arrows to change the setting.    Select AM or PM 
from the drop-down list.

4. Next to Alarm Text, type the text you want displayed in the alarm message.

5. Specify whether you want the alarm to go off on a regular basis or once only.

n Choose Recurring and select a day if you want the alarm to go off on the same day of every 
week.

n Choose Date and enter the specific day, month, and year if you want the alarm to go off only 
once.    Enter the date in the format DD/MM/YY. You can also click the up and down arrow buttons
to change the date.

6. If the alarm is to launch a program automatically, enter the path of the program and the working 
directory under Optional Alarm Actions. Use the Browse button to help locate the program and its 
command line, and choose the Run Minimized option if you want the program to be minimized when 
you open it.

7. Choose the alarm's sound from the Sound drop-down list. To hear a sound, select it and click Play 
Sound.    

If you did not install the Sound Driver for PC-Speaker during the Dashboard installation procedure, 
you cannot hear sound with the alarm.    For instructions on installing the driver, see your Dashboard 
Owner's Handbook.

8. Click OK.

See Also
Customizing the Alarm Clock
Using Custom Dashboard Configurations
Clock and Calendar Preferences



Setting Dashboard Preferences
You can use Dashboard's Preferences to run Dashboard as a shell, to modify the Dashboard window's 
appearance, to configure hotkeys and mouse buttons, and to create toolbars. The options for setting 
these preferences are divided into five cards in Dashboard Preferences. For instructions on using these 
options, click on one of the following procedures: 

Setting Color Preferences for Dashboard
Setting Main Preferences for Dashboard
Setting Toolbar Preferences for Dashboard
Setting Font Preferences for Dashboard
Setting Hotkey Preferences for Dashboard



Launching Programs with Quick Launch Buttons
You can create a set of Quick Launch buttons for the programs you use most often. Once a program has 
been assigned to a Quick Launch button, you can use the button to launch the program.

n Click the Quick Launch button.

or

n Drag the Quick Launch button to an extended screen.

If there are more Quick Launch buttons than can be shown at one time, use the scroll arrows to display 
buttons not currently in view.

You can view the path and name of an application by clicking the right mouse button on the applications 
Quick Launch button, either in the Dashboard window or on the toolbar.    A pop-up box opens, displaying 
the applications path and name.

See Also
Creating Quick Launch Buttons
Launching Programs by Dragging
Launching Programs with the Clock Alarm or Calendar Alarm
Launching Programs with the Command Prompt
Launching Programs with the Layout Menu
Launching Programs with the Program Menu
Launching Programs with a ProgramWindow
Launching Programs with the Run Command



Launching Programs with the Program Menu
1. Select a program group from the Program Menu.

n Click the Program Group button to see the program items listed on a menu.

If the Program group is not displayed on Dashboard, click the scroll arrows to display them.

2. Launch the program.

n Click the program item in the menu.

or

n Drag the program from the menu to an extended screen.

See Also
Launching Programs with the Clock Alarm or Calendar Alarm
Launching Programs with the Command Prompt
Launching Programs by Dragging
Launching Programs with the Layout Menu
Launching Programs with a ProgramWindow
Launching Programs with the Quick Launch Buttons
Launching Programs with the Run Command
Managing Program Groups



Launching Programs with the Layout Menu
1. Click the Layout Menu button (the third button on the left side of the Title Bar) or choose Layout Menu

from the System Menu.

The Layout menu contains the Manage Layouts and Save Layout commands, a list of previously 
saved layouts, as well as a sample layout. The sample layout contains the Control Panel, Notepad, 
and Paintbrush.

2. Click the layout that you want to load.

All the programs associated with the selected layout are launched.    The programs are displayed on 
the extended screens according to the arrangement you saved.

See Also
Launching Programs by Dragging
Launching Programs with the Clock Alarm or Calendar Alarm
Launching Programs with the Command Prompt
Launching Programs with the Program Menu
Launching Programs with a ProgramWindow
Launching Programs with the Quick Launch Buttons
Launching Programs with the Run Command



Launching Programs with the Run Command
1. Open the Dashboard Run dialog box.

n Double-click on the Task menu.

or 

n Choose Dashboard Run from the Task menu

or

n Press the hotkey you specified in the Dashboard Hotkeys preferences.

2. Choose the Run Minimized option if you want the program you're launching to be minimized when 
you open it.

3. Launch the program you want to use.

n In the Command Line box or the Command Prompt box, enter the command line for the program 
to run and click Run. 

If you don't know the command line, click the Browse button or enter DOS commands in the 
Command Prompt box to locate the program file.

or

n If the Command Prompt box already contains the program's executable file, double-click on the 
file or drag it to an extended screen. You can also select the file by pressing Shift-F8 to move the 
keyboard focus into the past commands, then press the scroll arrows to scroll up and down 
through the commands.

or

n Click the arrow on the Command Line box to see the last 20 commands used. If the program's 
executable file is displayed, select the file and click Run.

See Also
Launching Programs by Dragging
Launching Programs with the Clock Alarm or Calendar Alarm
Launching Programs with the Command Prompt
Launching Programs with the Layout Menu
Launching Programs with the Program Menu
Launching Programs with a ProgramWindow
Launching Programs with Quick Launch Buttons
Using the Command Prompt 



Managing Extended Screens
Dashboard's extended screens make it possible to work with your computer as if it had several screens 
attached to it. Each extended screen on Dashboard represents a full-screen view.

The extended screens contain mini-windows that represent each open program. The size and position of 
each mini-window on the extended screen is exactly proportional to the size and position of the actual 
program window on your full screen. For example, if you're running File Manager, and the File Manager 
window fills 3/4 of the screen, then the File Manager mini-window will fill 3/4 of the extended screen.    
Similarly, a minimize program would be represented by a minimized icon on the extended screen. 

The extended screens are completely interactive with the full-screen views. If you move or resize a 
program window on the full screen, the mini-window moves and resizes in a corresponding way.    If you 
bring one program to the front of another, the mini-windows on the extended screens will reflect the 
change. Also, if you move mini-windows on the extended screens, the programs they represent will move 
on the full screen.

To switch back and forth among different programs, click the selector button under the extended screen 
showing the window you want to view or double-click the extended screen's background.    You can also 
configure a hotkey for each screen in the Extended Screens Preferences. You can designate programs to 
be "Sticky Apps" so that they are always displayed, regardless of which extended screen you are in.

To move windows among the extended screens, drag the mini-windows or mini-icons in the Dashboard 
extended screens, or move the full-sized windows by dragging on the title bar.

You can launch programs by dragging them to an extended screen from the Program Menu or Program 
Menu toolbar, a program window, the Quick Launch panel or toolbar, or the Command Prompt in the Run 
dialog box to an extended screen.

You can customize the Extended Screens in the Extended Screens Preferences.    To display the 
Extended Screens Preferences, double-click the right mouse button on one of the extended screens.

See Also
Customizing Extended Screens 
Launching Programs by Dragging 
Setting Hotkey Preferences for Extended Screens 
Setting Main Preferences for Extended Screens 
Setting Sticky Apps Preferences for Extended Screens 



Managing Program Groups with the Program Menu
The row of Program Menu buttons under Dashboard's title bar lists the program groups in Windows' 
Program Manager. In Dashboard's default configuration, the program items are listed alphabetically. You 
can change a setting in the DASH.INI file so that the program groups are listed in the same order as they 
appear in the Program Manager windows.

When you click a program group button, the list for that group opens. If a program group contains a 
subgroup, the subgroup name appears at the beginning of the list, and you can click the subgroup name 
to view a list of its programs. To return to the main program group list, click the program group name at 
the top of the subgroup list. The name of the group you are currently viewing is the first item on the menu.
To open the program window corresponding to the group, click the group name. 

Adding a new program menu button
1. Double-click the right mouse button one of the Program Menu buttons to open the Customize dialog 

box with Program Menu Preferences.

2. Click the New button.

3. At the New Program Group dialog box, enter the name of the new group and select a color key 
setting.    You can also enter the name of the group file if you want. 

4. Click OK.

Hiding a program group on Dashboard
1. Double-click the right mouse button on one of the Program Menu buttons to open the Customize 

dialog box with Program Menu Preferences.

2. Click the program group you want to hide.

3. Click Hide Group. 

If you want to show the program group again, click the group and click Show Group.

Rearranging the Program Menu with the Customize dialog box
1. Double-click the right mouse button on one of the Program Menu buttons to open the Customize 

dialog box with Program Menu Preferences.

2. Click the program group you want to move in the list and drag it to its new position in the list. 

In Dashboard's horizontal orientation, the top-to-bottom sequence in the list corresponds to how 
program groups are arranged from left to right on Dashboard. 

In Dashboard's vertical orientation, the top-to-bottom sequence in the list corresponds to how 
program groups are arranged from top to bottom on Dashboard. 

Rearranging the Program Menu by dragging
n Drag the button you want to move and drop it in its new position in the Program Menu or Program 

Menu toolbar.

Listing Program Menu Items in the same order as in the Program Manager windows
1. Double-click on the DASH.INI file to open it as a Notepad file.

2. In the Programs section of the .INI file, change the setting to:

NoMenuSort=1

3. Choose Save from the Notepad File menu.

4. Choose Exit from the Notepad File menu.



5. If the Dashboard is running, close and re-open it.

Deleting a group from Dashboard
1. Double-click the right mouse button on one of the Program Menu buttons to open the Customize 

dialog box with Program Menu Preferences.

2. Click the program group you want to delete from the list of program groups. 

3. Click Delete.

This will delete the program group and associated file from Dashboard and the Program Manager.

Modifying a program group's color tab or description
1. Double-click the right mouse button on one of the Program Menu buttons to open the Customize 

dialog box with Program Menu Preferences.

2. Click a group in the Program Groups list.

3. Click Modify.

4. Enter a new group description or select a new color tab setting.

The group description you enter will appear on the Dashboard program menu button.

Specifying a button height for the Program Menu
1. Double-click the right mouse button on one of the Program Menu buttons to open the Customize 

dialog box with Program Menu Preferences.

2. Use the Show 2nd row of text option to display two rows of text on the Program Menu buttons.

Choosing whether to display color tabs in the Program Menu
1. Double-click the right mouse button on one of the Program Menu buttons to open the Customize 

dialog box with Program Menu Preferences.

2. Use the Show Color Keys option to add color tabs on the Program Menu buttons.

Updating Dashboard with changes made in Program Manager
When you make changes to the Program Manager's program groups, the changes are not reflected 
immediately in Dashboard. If you quit Dashboard and then launch Dashboard again, the changes to the 
Program Manager groups will be reflected in Dashboard's program groups.    You can also use the 
Customize dialog box to update the Dashboard groups.

1. Double-click the right mouse button on one of the Program Menu buttons to open the Customize 
dialog box with Program Menu Preferences.

2. Click the Reread from Program Manager button.

See Also
Launching Programs by Dragging 
Launching Programs with the Program Menu 
Managing Program Groups with Program Windows 
Program Group Preferences 



Moving and Resizing Dashboard
You can move Dashboard to any place on your computer screen, and you can choose between running 
Dashboard in a horizontal or vertical orientation. You can change the size of the Dashboard window, and 
you can also resize individual panels within the window.

Moving Dashboard
1. Put the cursor on the Title Bar.

2. Drag Dashboard to a new place on the screen.

Running Dashboard in a Horizontal or Vertical Orientation
1. Click the Customize button.

2. In Dashboard Preferences, click the Main tab.

3. In Window Orientation, choose Horizontal or Vertical.

4. Click Done.

Resizing Dashboard
1. Put the cursor on the sizing border on the left or right edge or on the top or bottom of Dashboard. The

cursor becomes a two-headed arrow.

2. Drag to resize. 

When Dashboard is in its horizontal orientation, you can change Dashboard's height by dragging the 
window's top or bottom border. When Dashboard is in its vertical orientation, you can change 
Dashboard's width by dragging the window's left or right border.

In the horizontal orientation, the width of the window size is limited by the number of items on 
Dashboard that can be expanded or hidden from view.    In the vertical orientation, the height of the 
window size is limited by the number of items on Dashboard. For example, if the Dashboard window 
only has one printer icon and one Quick Launch button, there's probably no reason to resize.    But if 
your computer has multiple printers, you may have to resize it to display all the printers. You cannot 
make Dashboard bigger than is necessary to display all items adequately.

Enlarging Dashboard may cause some of its panels (such as the panels for the printers or the Quick 
Launch buttons) to be too big to show all of their items.    When that happens, panels on the left (on 
the top in the vertical orientation) will have priority over panels on the right (on the bottom in the 
vertical orientation).    For example, if the Quick Launch panel is to the left of the printers' panel, more 
Quick Launch buttons will be visible than printers.    You can use the scroll arrows to see the other 
printers, or you can resize the printer panel by holding down the Shift key and dragging the panel 
borders.

Resizing Individual Panels
You can resize the Printers and Quick Launch panels on Dashboard and, when Dashboard is running in 
the vertical orientation, you can resize the Program Menu as well.

1. Hold down the Shift key and place the cursor over any of the panel borders.

The cursor changes to a two-headed arrow.

2. Press the mouse button over a border.

A dark gray box appears over the panel borders.

3. Drag any of the borders until the panel is the size you want.



Printing and Faxing
The Printer Manager controls all of the printers, fax machines, and plotters you have installed and 
configured in Windows.

Printing from Dashboard
1. Select a file to print.

You can select a file from the File Manager, from the Program Menu or Program Menu toolbar, from a 
program group window, from the Quick Launch panel or toolbar, or from the Command Prompt in the 
Run dialog box.

2. Drag the file to the appropriate printer icon on Dashboard. If the printer is not currently displayed on 
Dashboard, use the scroll arrows on Dashboard to display it.

If the application with which the file was created is not registered properly with Windows, you cannot 
print the file by dragging it to Dashboard. You can check the Windows Registration Info Editor to see 
whether your application is registered. For instructions on opening the Windows Registration Info 
Editor and for registering an application, see the Readme.txt file that came with your Dashboard 
program.

Choosing a default printer
The green light denotes the default printer. To choose a different default printer, click the default printer 
button.

Scrolling in Dashboard to see other printers
If Dashboard is not wide enough to display all printers, the Print Manager portion of Dashboard will 
include scroll arrows. Click the scroll arrows to see printers that aren't currently visible.

Displaying a printer's full name and description
Click a printer icon to see the full name and description.

Working with the printer's configuration
Double-click to see the Printer Configuration box, and change the appropriate settings.

Installing new printers
The Printer Manager offers a quick and easy way to handle all your installed printers. However, the 
Printer Manager does not install printers. To install a new printer, use the Windows Control Panel. Refer to
your Windows documentation for more information.

See Also
Dragging and Dropping 
Printer Manager Preferences 



Using Dashboard Keyboard and Mouse Shortcuts
You can operate Dashboard with the keyboard as well as the mouse. Some keyboard operations are 
available in Dashboard when you install the program. You can also configure additional hotkeys and 
mouse buttons to perform other tasks.

Using Dashboard's pre-set keyboard operations

Press this key... To do this...
F12 Bring the Dashboard window to the front of other windows or, if the 

Dashboard window is already in front, send it to the back of all other windows.    
(F12 is the default key for this function.    You can use Dashboard Hotkey 
Preferences in the Customize dialog box to set another hotkey for this function.)

Shift When you hold the Shift key and click the Dashboard icon, Dashboard 
opens without launching the startup layout specified in the Save Layout dialog 
box.

Alt-(character) Choose a button or menu command that has its selection character underlined.    
For example, if a button is labeled Add, the letter A is the letter for selecting the 
Add key, and pressing Alt-A is equivalent to clicking the button.

Alt-Spacebar Show the System Menu.

Shift-F8 In the DOS Command box when the DOS Command Window is active, press 
Shift-F8 to use the up and down cursor keys to move through the command 
window. Press Shift-F8 again, and the up and down cursor keys cycle through a 
history of recent commands.

Ctrl-Alt-Cursor Keys Move (reorder) items on a list in the Customize dialog box.

Ctrl-F6 Cycle through Dashboard and any open dialog boxes and toolbars.

Cursor Keys Select items from menus and from groups within
(up/down/left/right) a dialog box.    If you use Tab to select an item on the Dashboard window, using 

the cursor keys will cycle through individual components of the items.

End Move to last item on a list.

Enter Equivalent to double-clicking the mouse on the selected item. In a dialog 
box, equivalent to clicking on the OK button.

Esc Exit a menu. Cancel out of a dialog box.

Home Move to first item in a list.

Shift-Tab Tab key functions in reverse.

Spacebar When you press Tab or Shift-Tab to select a Dashboard item, the keyboard focus 
is then on that item.    Pressing the spacebar then selects that item. Using the 
spacebar is equivalent to clicking the mouse.

Tab When the Dashboard window has the focus, use the Tab key to cycle 
through the Dashboard panels.    When a dialog box is active, the Tab key cycles 
through groups in it. 

Creating Hotkeys for Extended Screens
1. Double-click the right mouse button on one of the extended screens to open the Customize dialog 

box with Extended Screens Preferences.

2. Click the Hotkeys tab.

3. Enter the hotkey you want for each extended screen. 



In Dashboard's horizontal orientation, the numerical sequence of screens in the dialog box 
corresponds to the left-to-right order of the screens on Dashboard.    In the vertical orientation, the 
numerical sequence in the dialog box corresponds to the top-to-bottom order on Dashboard. For 
example, Screen #1 corresponds to the left screen in the horizontal window and to the top screen in 
the vertical window.

To enter a hotkey, click in the Hotkeys box and press the key combination you wish to set.

You can enter a function key (for example, F4) or a number, letter, or character key. If you enter any 
key other than a function key, Dashboard inserts the Ctrl and Alt keys in front of your key. 

If you want to clear the existing Hotkey, click in the Hotkey box and press Del or Backspace.

Creating a shortcut key for a Quick Launch button
1. Double-click the right mouse button on a Quick Launch button to open the Customize dialog box with 

Quick Launch Preferences.

2. Click the Quick Launch button in the list for which you want to specify a hotkey.

3. Enter a shortcut key in the Shortcut Key.    

To enter a shortcut key, click in the Shortcut Key box and press the key combination you wish to set.

You can enter a function key (for example, F4) or a number, letter, or character key. If you enter any 
key other than a function key, Dashboard inserts the Ctrl and Alt keys in front of your key. 

If you want to clear the existing shortcut key, click in the Shortcut Key box and press Del or 
Backspace.

If you use this shortcut key when you have a full-screen DOS application running, Dashboard will not 
launch the application associated with the shortcut key.    If the application is already running, 
Dashboard will bring the window to the front of the desktop.

Creating hotkeys and mouse shortcuts to toggle the Dashboard window
You can create a hotkey and a mouse shortcut that will bring Dashboard to the front of all other windows 
or, if Dashboard is already at the front, send it to the back of the other windows.

If you are running a full-screen DOS application, you cannot use the mouse shortcut to toggle Dashboard;
you can only use the shortcut key.    Setting the mouse shortcut to be a double-click will not work in 
applications that do not support a double-click.

1. Click the Customize button.

2. In Dashboard Preferences, click the Hotkeys tab.

3. If you want to use the keyboard to toggle Dashboard, click in the Shortcut Key box and execute the 
key combination you wish to set.

To enter a shortcut key, click in the Shortcut Key box and press the key combination you wish to set.

You can enter a function key (for example, F4) or a number, letter, or character key. If you enter any 
key other than a function key, Dashboard inserts the Ctrl and Alt keys in front of your key. If you enter 
a key combination that is used in another application, the corresponding function in that application 
will override the Dashboard hotkey.

4. If you want to use the mouse to activate Dashboard, click in the Mouse Shortcut box and execute the 
mouse combination that you want to use.

The mouse shortcut does not activate Dashboard if the currently active window is a full-screen DOS 
application.

VIewing Quick Launch button names with the mouse
You can use the mouse to view the name and path of an application from the Quick Launch panel or 



toolbar.

n Click the right mouse button on the appropriate Quick Launch button.

A pop-up box opens, displaying the name and path of the buttons application.



Creating Layouts
You can use Dashboard layouts to open all the programs you want to work with, already positioned in the 
extended screens and ready to go.    For instance, if you want to work with WinWord on extended screen 
1, Paintbrush on extended screen 2, and the File Manager minimized on extended screen 3, you can 
save that arrangement as a layout.    Then, when you load that layout, all of those programs will 
automatically open in the original screen locations.

If you have another project that requires working with some other programs in a different arrangement, 
you can save them as another layout and reload them with a single command when you need to work on 
this project.

1. Open all the programs you want to include in the layout.

2. Arrange the programs on the extended screens.

3. Choose Save Layout from the Layout Menu.

4. To automatically load this layout every time you start Dashboard, choose the Load layout on startup 
option.

If you want to override this option when you start Dashboard, hold down the Shift key when you click 
the Dashboard icon. Dashboard will not launch the startup layout.

5. Enter a name for the layout.

6. Click OK.



Editing Layouts
1. At the Save Layout dialog box, select a program from the programs list then click Edit.

The Edit Layout dialog box appears.    The dialog box contains the command line and working 
directory for the selected program.

You cannot edit the command line information.

2. Enter a name for the program in the Application Name box.    This name is a descriptive name, not a 
filename.

3. Enter the    working directory in the Working Directory box.

4. If you want to open a specific file when you launch the application, enter the file's complete path in the
Parameters box.

5. Choose a size for the program window from the Window Size pull-down menu. You can choose 
Normal, Minimized, or Maximized for the window size.

6. To exit the Edit Layout dialog box and save any changes, click OK.

7. To exit the Edit Layout dialog box without saving changes, click Cancel.



Loading Layouts
Once you have created a layout by saving it, you can launch all its associated applications quickly and 
easily by loading that layout. 

Occasionally, a layout does not load correctly. When you save a Dashboard layout, Dashboard looks at all
the currently open programs, finds all the files that control the programs' windows, and saves these file 
names with the layout.    The next time you load that layout, Dashboard uses these file names to launch 
the programs.    With most programs, the file that controls the program's window is the same file used to 
launch it. However, in some instances, the file that controls a program's currently open window is not the 
same as the one that launches the program. If this occurs, you can update the layout's alias in the 
DASH.INI to correct the problem. For instructions on updating the alias, see the Dashboard readme file 
READADV.WRI.

1. Click the Layout button (the third button on the left side of the Title Bar) or choose Layout Menu from 
the System Menu.

The Layout menu contains a list of previously saved layouts, as well as a sample layout. The sample 
layout contains the Control Panel, Notepad, and Paintbrush.

2. Click the layout that you want to load.

All the programs associated with the selected layout are launched.    



Managing Layouts
To change the program information in a previously saved layout, choose Manage Layouts from the Layout
Menu.    The Manage Layouts dialog box opens.    Use the Manage Layouts dialog box to make any of the 
following changes to your layout.

Removing a layout
1. Select the layout in the Layout list.

2.  Click Delete Layout.

Changing the name of a layout
1. Select the layout in the Layout list.

2. Click Rename.

3. Enter the new name in the Rename dialog box and click OK.

Loading a specific layout with Dashboard
1. Select a layout in the list.

2. Choose the Load layout on startup option.

The next time you start Dashboard, Dashboard will automatically launch the layout.

If you want to override this option when you start Dashboard, hold down the Shift key when you click the 
Dashboard icon. Dashboard will not launch the startup layout.

Removing a Program from a Layout
1. Select the program in the Applications for Layout list.

2. Click Delete.

Editing a program's specifics
1. Select the program in the Applications for Layout list.

2. Click Edit.

3. Enter the appropriate information in the Edit Layout dialog box.

Exiting the Manage Layouts dialog box
1. To exit the Manage Layouts dialog box and save any changes made, click Save Changes.

2. To exit the Manage Layouts dialog box without saving changes, click Cancel.



Launching Programs with the Clock Alarm or Calendar Alarm
1. Double-click the Alarm Clock on Dashboard or click a date in the Calendar.    You can also click the 

Alarms button in the Clock Preferences dialog box.

The Clock Alarms dialog box opens.

2. Click Add to add a new alarm or Edit to change an existing alarm.

The Alarms Setting dialog box appears.

3. Set the time you want Dashboard to launch the program.

4. If you want Dashboard to display a message when it launches the program, enter the alarm text.

5. Specify whether you want Dashboard to launch the program on a regular basis or once only.

n Choose Recurring and select a day if you want Dashboard to launch the program on the same 
day of every week.

n Choose Date and enter the exact day, month, and year if you want Dashboard to launch the 
program once only.    Enter the date in the format DD/MM/YY. You can also click the up and down 
arrow buttons to change the date. 

6. If you want the alarm to play a sound, click Alarm Sound to choose a sound.

7. Enter the name, path, and working directory for the program in the Run Program box.

8. If you want the program to run minimized, choose the Run Minimized option.

9. Click OK.

See Also
The Alarm Settings Dialog Box
Launching Programs by Dragging
Launching Programs with the Command Prompt
Launching Programs with the Layout Menu
Launching Programs with the Program Menu
Launching Programs with a Program Window
Launching Programs with Quick Launch Buttons
Launching Programs with the Run Command



Managing Program Groups with Program Windows
When you double-click a program group in the Program Menu, the Dashboard program group window 
opens and displays program items as icons. The original order of these icons is determined by their order 
in the Program Manager.    You can use the program windows to launch programs. You can change the 
position of any icon by dragging it to a new place within the window. You can also click and drag programs
into other group windows, copy programs into other group windows, and even create groups within 
groups.    

Launching programs from a program window
1. Open the group window from which you want to launch a program.

2. Double-click the program icon.

Moving and copying a program from one group to another by dragging the icon
1. Open both group windows by double-clicking in the Dashboard Program Menu.

2. Click and drag the program item icon from one window to the next to move the item. To copy a 
program, hold the Control key and click to drag the program item to another window.

Moving a program from one group to another using the Move command
1. Open the group window from which you want to move the program.

2. Select the program item you want to move.

3. Choose Move from the File menu.

4. Click the arrow on the To Group drop-down list and click the program you want to move.

5. Click OK.

Copying a program from one group to another
1. Open the group window from which you want to copy the program.

2. Select the program item you want to copy.

3. Choose Copy from the File menu.

4. Click the arrow on the To Group drop-down list and click the program you want to copy.

5. Click OK.

Creating a new program group within an existing program group
1. Open the existing group window by double-clicking in the Dashboard Program Menu.

2. Choose New Group from the File menu.

3. Type a name for the group and click OK. Enter a group file name as an option. 

The new group is displayed as an icon. 

4. Double-click the icon to open the new group window.

Creating a new program item
1. Open the group window by double-clicking in the Dashboard Program Menu.

2. Choose New Item from the File menu.

4. Enter a title for the program item.

5. Enter the correct command line (path name and file name) and working directory for the program. 
Click Browse if you don't know the path name for the program.

6. If you want to use a shortcut key to launch the program, click in the Shortcut Key box and press the 
key combination you wish to set.



You can enter a function key (for example, F4) or a number, letter, or character key. If you enter any 
key other than a function key, Dashboard inserts the Ctrl and Alt keys in front of your key. If you enter 
a key combination that is used in another application, the corresponding function in that application 
will override the Dashboard hotkey.

If you want to clear the existing Shortcut Key, click in the Shortcut Key box and press Del or 
Backspace.

If you use this shortcut key when you have a full-screen DOS application running, Dashboard will not 
launch the application associated with the shortcut key.    If the application is already running, 
Dashboard will bring the window to the front of the desktop.

7. Choose the Run Minimized option if you want the program to be minimized when you open it.

8. Click OK.

Changing a program item's properties
1. Open the group window by double-clicking in the Dashboard Program Menu.

2. Click the program item for which you want to change the properties.

3. Choose Properties from the File menu.

4. Enter the new information in the Program Item Properties dialog box.

5. Click OK.

Deleting a program item or program group
1. Open the group window by double-clicking in the Dashboard Program Menu.

2. Click the program item or program group you want to delete.

3. Choose Delete from the File menu.

Deleting a program group will delete all of the items and groups contained within it.

Arranging icons in program windows
You can arrange icons manually in program windows, or you can set up a program window so that any 
icon you add is automatically positioned in line with the current window arrangement.

1. To arrange icons manually, choose Arrange Icons or Arrange by Title from the Window menu.

Choose Arrange Icons if you want to arrange the icons with an even amount of space between them.  
You can set the spacing for the window in the Desktop Control Panel..

Choose Arrange by Title if you want to arrange the icons alphabetically.

2. To arrange icons automatically, choose Auto Arrange from the Window menu.

When you add a new icon, it will be positioned with an even amount of space between it and the 
nearest icon.    You can set the spacing for the window in the Desktop Control Panel.

See Also
Launching Programs by Dragging 
Managing Program Groups with the Program Menu



Running Dashboard as a Shell
If you run Dashboard as a shell program, Dashboard will be the first program to run when you start 
Windows, instead of the Program Manager.    Running Dashboard as a shell lets you control Windows 
with Dashboard only.

When youre running Dashboard as a shell and you use the Run command to install a new application, 
Dashboard launches the Program Manager to install the application.    The Progam Manager remains 
open until you close it.

If you are running Dashboard as a shell, when you close Dashboard, a prompt appears asking if you want
to exit Windows. You can change the appropriate setting in your DASH.INI file so that the prompt doesn't 
appear.

Customizing Dashboard to run as a shell
1. Click the Customize button.

2. In Dashboard Preferences, click the Main tab.

3. Choose the Use Dashboard as Windows Shell option.

4. Click Done.

Dashboard displays a message saying you need to restart Windows to implement the change.

5. Click Yes to restart Windows immediately or click No to remain in Windows and continue to work with 
Dashboard.

If you click No, the next time you restart Windows, Dashboard will be run as the shell.

Canceling the Dashboard Exit Windows Reminder
The first "paragraph" in the DASH.INI file, named Dash, controls the Exit Windows reminder box that 
appears when closing Dashboard if it is running as the Windows shell.

In this paragraph, the two possible settings are:

NoExitPrompt=0 Exit Windows reminder box appears

NoExitPrompt=1 Reminder box does not appear

To change the setting:

1. Double-click on the DASH.INI file to open it as a Notepad file.

2. In the Dash section of the .INI file, change the setting to:

NoExitPrompt=1

4. Choose Save from the Notepad File menu.

5. Choose Exit from the Notepad File menu.

6. If the Dashboard is running, close and re-open it.

The Exit Windows reminder box will not appear when Dashboard is closed.    To see the reminder box, re-
set the Dash paragraph to NoExitPrompt=0.



Using Dashboard in the Vertical Orientation
When you install and run Dashboard for the first time, the Dashboard window is displayed in a horizontal 
orientation across the screen.    You can customize Dashboard to display the window in a vertical 
orientation.

When you run Dashboard in the vertical orientation, the panels are displayed according to the order in the
Customize dialog box.    The top-to-bottom sequence in Dashboard corresponds to the top-to-bottom 
sequence in the dialog box. The vertical position of extended screens corresponds to the screens position
in the horizontal orientation.    For example, the top extended screen in the vertical orientation 
corresponds to the left extended screen in the horizontal orientation.

1. Click the Customize button.

2. In Dashboard Preferences, click the Main tab.

3. Under Window Orientation, choose the Vertical option.

4. Click Done.



Using Dashboard's Readme Files
Your Dashboard program disk contains    two readme files that are copied to your hard disk during the 
Dashboard installation process.    These readme files contain supplemental information about Dashboard 
for Windows that is not included in your Owner's Handbook.

README.WRI contains information about the following subjects:

n Installing Dashboard 2.0 over 1.X.

n New Dashboard features.

n New Dashboard shortcut keys.

n Using Dashboard Run DOS commands.

n Using Dashboard with Norton Desktop for Windows, WordPerfect for Windows, PC Tools for 
Windows, Microsoft Mail, Paradox, or Microsoft Mouse Driver 9.0.

n Solutions to the various problems.

n Removing Dashboard from your computer.

READADV.WRI contains tips on how to customize Dashboard using the DASH.INI file.    You can make 
the following changes using the DASH.INI file:

n Cancel the Dashboard Exit Windows reminder.

n Hide a Dashboard panel.

n Change the order of program items on the Program Menu.

n Update layout aliases if your Dashboard layouts don't load correctly.

n Add new sound files.

n Change the RGB values for Dashboard's color scheme options.

n Adjust Dashboard's opening screen position.

n Change the first day of the Dashboard calendar week.

To see any of this information, open the appropriate readme file.



Removing Dashboard
If you want to remove Dashboard from your system, you can do so with the Remove Dashboard icon in 
your Dashboard program group 

1. Double-click the Remove Dashboard icon.

Dashboard displays a message asking if you want to remove Dashboard for Windows from your 
system.

2. If you don't want to remove Dashboard, click Cancel.

If you want to remove Dashboard, click Remove.

Dashboard displays the Remove Dashboard dialog box containing the path for the Dashboard 
program.

3. If you don't want to remove Dashboard, click Cancel.

If you want to remove Dashboard, click OK.

Dashboard is removed from your system.



Customizing the Calendar
You can use Calendar Preferences in the Customize dialog box to set highlight and alarm colors for your 
Calendar and to go directly to the current date in the calendar. You can also set the first day of the 
calendar to either Sunday or Monday by changing a setting in the DASH.INI file.

Customizing the Calendar with the Customize dialog box
1. Double-click the right mouse button on the calendar or the clock to open the Customize dialog box 

with Calendar Preferences.

If the calendar or clock is not currently displayed on Dashboard, click the Customize button and then 
click Clock/Calendar in the list.

2. To select a highlight color for the current date, click on the appropriate color under Today.

3. To select a highlight color for days with assigned alarms, click the appropriate color under Alarms.

4. If you don't want any highlight colors displayed on the calendar, choose the No HIghlights option.

5. To display the current date on the calendar, click Go to Today.

6. To close the dialog box, click Done.

Customizing the calendar with the DASH.INI file
1. Double-click on the DASH.INI file to open it as a Notepad file.

2. In the Calendar section of the .INI file, change the setting to:

Weekstart=0;          week starts on Sunday (the default in U.S.)

Weekstart=1;          week starts on Monday

3. Choose Save from the Notepad File menu.

4. Choose Exit from the Notepad File menu.

5. If the Dashboard is running, close and re-open it.

The Dashboard Calendar will now reflect the change.



Creating Sticky Apps
When you switch from one extended screen to another, Dashboard displays the applications in the new 
extended screens.    If you want certain applications to be displayed all the time, regardless of which 
extended screen you are in, you can designate that application to be a Sticky App. 

1. Launch the application you want to designate a Sticky App.

2. Double-click the right mouse button on one of the extended screens to open the Customize dialog 
box with Extended Screens Preferences.

3. Click the Sticky Apps tab.

4. Click Add.

5. In the Add Sticky App dialog box, select the application you want to designate as a Sticky App from 
the list of currently running applications.

6. Click OK.

7. In the Customize dialog box, click Done.

See Also
The Add Sticky App Dialog Box



Using the Dashboard Task Manager
The Dashboard Task Manager contains a list of currently running programs and lets you easily switch 
between these programs.    You can also use the Dashboard Task Manager to close programs, to 
rearrange windows on screen, and to view current task information.

1. Open the Dashboard Task Manager.

n Double-click on the Windows background. 

or

n Choose Switch To from the System menu.

or

n Press Ctrl-Esc on the keyboard.

2. To switch to another program, select that program in the Task List and click Switch To.

3. To close a program, select that program in the Task List and click Close Selected.

4. To view information about a program's memory usage, select the program and click Task Info.

5. To arrange all mini-windows in the extended screens in a Tile arrangement, click Tile.

6. To arrange all mini-windows in the extended screens in a Cascade arrangement, click Cascade.

7. To realign all minimized icons in each extended screen, click Arrange Icons.

8. To close the dialog box, click Done.



Using Toolbars
You can select certain Dashboard panels to be toolbars, snap-off panels that are displayed separately 
from the Dashboard window. You can create toolbars for the Program Menu, the Quick Launch panel, and
the Printer Manager. You can position these toolbars anywhere on screen. The toolbars are always 
displayed, even when you switch to another extended screen.

Once you have created a toolbar, you can use that toolbar to perform all the functions of the original 
panel. For example, you can launch a program by dragging a Quick Launch button from the Quick Launch
panel or toolbar to an extended screen. Any changes you make in the Customize dialog box affect both 
the panel and the toolbar. If you choose the Mini button style in Quick Launch preferences, the buttons on
the Dashboard Quick Launch panel and the toolbar will be displayed in the Mini style. Similarly, if you 
make a change to a toolbar, the change is reflected in the original panel, and vice versa. For example, if 
you drag a Program Menu button to a new position on the Program Menu toolbar, you will see the new 
arrangement in the Program Menu when you reconfigure the Program Menu as a Dashboard panel.

1. Click the Customize button.

2. In Dashboard Preferences, click the Toolbars tab.

3. Select the check box for the panels you want as toolbars.

4. If you want the toolbars to be minimized when you minimize Dashboard, choose the Toolbars 
minimize with Dash option.

5. Click Done.

6. To open the toolbar, click the Toolbar panel on Dashboard.



Dragging and Dropping
You can use Dashboard's Drag and Drop feature to launch programs, print files, create Quick Launch 
buttons, and arrange items on Dashboard.

Launching a program
1. Select the program you want to launch.

You can select a program from the Program Menu on Dashboard or on the Program Menu toolbar, 
from a program window, from the File Manager, from the Command Prompt box in the Dashboard 
Run dialog box, or from the Quick Launch panel or toolbar.

2. Drag the program to an extended screen.

Printing a file
1. Select the file you want to launch.

You can select a file from the Program Menu or Program Menu toolbar, from a program window, from 
the File Manager, or from the Command Prompt box in the Dashboard Run dialog box.

2. Drag the file to the Printer Manager.

Creating a Quick Launch button
1. Select the file you want to launch.

You can select a file from the File Manager, Program Menu or Program Menu toolbar, or a program 
window.

2. Drag the program to the Quick Launch panel. 

Arranging items on Dashboard
You can move Quick Launch buttons, Program Menu buttons, and Printer Manager buttons around in 
their panel by dragging the buttons.

1. Select the button you want to move.

2. Drag the button to a new position in the panel.

See Also
Using Toolbars



Launching Programs by Dragging
1. Select the program you want to launch.

You can select a program from the Program Menu or Program Menu toolbar, from a Program 
Window, from the File Manager, from the Command Prompt box in the Dashboard Run dialog box, or 
from the Quick Launch panel or toolbar.

2. Drag the program to an extended screen.

See Also
Dragging and Dropping
Launching Programs with the Clock Alarm or Calendar Alarm
Launching Programs with the Command Prompt
Launching Programs with the Layout Menu
Launching Programs with the Program Menu
Launching Programs with a Program Window
Launching Programs with Quick Launch Buttons
Launching Programs with the Run Command



Setting Color Preferences for Dashboard
You can choose from several colors in which to display the Dashboard window and any toolbars.

1. Click the Customize button.

2. In Dashboard Preferences, click the Colors tab.

3. Select the color style you want.

n If you want to display Dashboard with the default colors, choose the Default Colors option.

n If you are using Dashboard on a gray-scale monitor, choose the Gray-Scale Colors option.

n If you want to display Dashboard with a custom color, select one of the color schemes. 

4. To save the changes and close the dialog box, click Done.

If you don't want to keep the changes, click Undo.

See Also
Using Custom Dashboard Configurations
Using Toolbars



Setting Main Preferences for Dashboard
Dashboard's Main Preferences lets you customize the main Dashboard window.

1. Click the Customize button.

2. In Dashboard Preferences, click the Main tab.

3. Choose the Dashboard always in front option if you want the Dashboard window in front of all other 
windows at all times.

If you don't choose the Dashboard always in front option, you can still bring Dashboard to the front 
using a hotkey or mouse shortcut.

4. Choose the Use Dashboard as Windows Shell option if you want Dashboard to be the first program to
run when you start Windows, instead of the Program Manager. 

5. Choose the Replace Windows Task Manager if you want to use the Dashboard Task Manager.

6. Choose the Show icons in menus and screens option if you want to display mini program icons on the
extended screens, Program Menu list, and the Task Menu.

7. Make a choice from the Title Bar Display drop-down list to customize the appearance of the 
Dashboard Title Bar.    

n Choose standard if you want the Title Bar to show only the window caption.

n Choose Clock/Calendar if you want the Title Bar to show the current date and time.

n Choose Resources if you want the Title Bar to show the status of your System Resources and 
memory.

8. Make a choice from the Minimized Display drop-down list to change the icon displayed when 
Dashboard is minimized. 

n Choose standard if you want the Minimized Display to show only the Dashboard icon. 

n Choose Extended Screens if you want the Minimized Display to show the compact Extended 
Screens icon.

You can switch screens by clicking on the little boxes in the minimized icon.

n Choose Resources if you want the Minimized Display to show the status of your System 
Resources.

9. Under Window Orientation, choose to display Dashboard in the horizontal or vertical orientation.

10. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

See Also
Using Custom Dashboard Configurations



Setting Toolbars Preferences for Dashboard
You can use the Toolbar Preferences to create Toolbars for the Quick Launch Panel, the Program Menu, 
and the Printer Manager.

1. Click the Customize button.

2. In Dashboard Preferences, click the Toolbars tab.

3. Choose the panels that you want to use as Toolbars.

4. If you want the Toolbars to be minimized when you minimize Dashboard, choose the Toolbars 
minimize with Dash option.

5. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

6. To open a Toolbar, click the Toolbar panel on Dashboard.

See Also
Using Custom Dashboard Configurations
Using Toolbars



Setting Font Preferences for Dashboard
You can use the Fonts Preferences to change the fonts used in the Dashboard window and the toolbars.

1. Click the Customize button.

2. In Dashboard Preferences, click the Fonts tab.

3. Choose the font type you want to use from the Font list box.

4. Choose the font size you want to use from the Font Size list box.

5. Choose the font style you want to use from the Font Style list box.

6. If you want to use the default font, click Default Font.

7. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

See Also
Using Custom Dashboard Configurations
Using Toolbars



Setting Hotkeys Preferences for Dashboard
You can use the Hotkeys Preferences to specify the keyboard or mouse combination that toggles 
Dashboard to the front and behind other windows. 

1. Click the Customize button.

2. In Dashboard Preferences, click the Hotkeys tab.

3. Enter a shortcut key if you want use the keyboard to toggle Dashboard in front of and behind other 
windows.

To enter a shortcut key, click in the Shortcut Key box and press the key combination you wish to set.

You can enter a function key (for example, F4) or a number, letter, or character key. If you enter any 
key other than a function key, Dashboard inserts the Ctrl and Alt keys in front of your key. If you enter 
a key combination that is used in another application, the corresponding function in that application 
will override the Dashboard hotkey.

If you want to clear the existing Shortcut Key, click in the Shortcut Key box and press Del or 
Backspace.

4. Enter a hotkey for the Dashboard Run dialog box if you want to use the keyboard to open the 
Dashboard Run dialog box.

5. Enter a mouse shortcut if you want to toggle the window using the mouse.

To enter a mouse shortcut, execute the button combination in the Mouse Shortcut box.

You can use any mouse button combination with the left, middle, or right button, except a single- or 
double-click with the left button.

If you are running a full-screen DOS application, you cannot use the mouse shortcut to toggle 
Dashboard; you can only use the shortcut key.    Also, if you are using applications that do not support
a double-click operation, you should not set the mouse shortcut to a double-click.

6. Click Done.

See Also
Setting Hotkey Preferences for Extended Screens
Using Custom Dashboard Configurations
Using Dashboard Keyboard and Mouse Shortcuts



Launching Programs with the Command Prompt
You can use Dashboard's Command Prompt to launch a program.

1. Open the Dashboard Run dialog box.

n Double-click on the Task menu.

or 

n Choose Dashboard Run from the Task menu.

or

n Press the hotkey you specified in the Dashboard Hotkeys preferences.

2. Choose the Run Minimized option if you want the program you're launching to be minimized when 
you open it.

3. Launch the program you want to use.

n In the Command Line box or the Command Prompt box, enter the command line for the program 
to run and click Run. 

If you don't know the command line, click the Browse button or enter DOS commands in the 
Command Prompt box to locate the program file.

or

n If the Command Prompt box already contains the program's executable file, double-click on the 
file or drag it to an extended screen.

or

n Click the arrow on the Command Line box to see the last 20 DOS commands used. If the 
program's executable file is displayed, select the file and click Run.

See Also
Launching Programs by Dragging
Launching Programs with the Clock Alarm or Calendar Alarm
Launching Programs with the Layout Menu
Launching Programs with the Program Menu
Launching Programs with a Program Window
Launching Programs with Quick Launch Buttons
Launching Programs with the Run Command
Using the Command Prompt



Using the Command Prompt
The Dashboard Command Prompt is located in the Dashboard Run dialog box.    You can use the 
Command Prompt to perform DOS commands.

1. Open the Dashboard Run dialog box.

n Double-click on the Task menu.

or 

n Choose Dashboard Run from the Task menu.

or

n Press the hotkey you specified in the Dashboard Hotkeys preferences.

2. Enter any DOS command in the Command Line box or the Command Prompt box.

You can also execute a previously entered DOS command by pressing Shift-F8 to move the keyboard
focus into the past commands, clicking the scroll arrows to scroll up and down through the 
commands, and then clicking the command you want to use.

3. Press Enter.

The following list shows you all the commands you can use at Dashboard's Command Prompt.    To view 
an explanation of a specific command, as well as the command's syntax, click the command in the list.

attrib
call
cd (chdir)
cls
copy
date
del (erase)
dir
echo
edit
exit
find
for
goto
help
if
label
md(mkdir)
path
pause
print
prompt
rd (rmdir) 
rem
ren (rename)
set
shift
sort
subst
time
type
ver
vol



xcopy
There are some differences between Dashboard Run commands and MS-DOS commands. For an 
explanation of these differences, see the Dashboard readme file README.WRI. 

If Dashboard does not support a DOS command, it will use a default PIF file called DBPROMPT.PIF file to
pass that command on to DOS, where it will be executed. DBPROMPT.PIF is located in the same 
directory as Dashboard. The results will be displayed in a window.    This window will remain open until 
you manually close it by double-clicking the Control menu.

You can tell when the DOS command is finished processing by the title bar of the window. When the 
processing is done, the title bar will read, Inactive DOS Prompt.    You can then manually close the 
window by double-clicking the Control menu.    If the command does not produce output to the screen, the
window will remain blank, and the title bar will change when processing is done.    You can then manually 
close the window.

The Dashboard Run dialog box does not support the Append, Choice, DOSkey, Graphics, Join, Fastopen,
Loadhigh, Share, or Defrag commands.

Copyright© 1992-1993 Summit Software Company.
All rights reserved.

See Also
Launching Programs with the Command Prompt



Setting Main Preferences for Extended Screens
The Main Extended Screens Preferences let you specify the number of extended screens you want on 
Dashboard, as well as the size and background of the screens.

1. Double-click the right mouse button on one of the extended screens to open the Customize dialog 
box with the Extended Screens Preferences.

If the Extended Screens are not currently displayed on Dashboard, click the Customize button and 
then click Extended Screens in the list.

2. Click an option to choose the number of extended screens. 

If a number is grayed out, there is not enough room on Dashboard for that many extended screens. 
To make more room on Dashboard, remove items from Dashboard by clicking on one of the 
Dashboard items listed in the Customize dialog box and selecting Hide Item.    You can then select a 
larger number of extended screens to display.

If you decrease the number of extended screens on Dashboard, any applications contained in the 
removed extended screens (the left or right screens) are moved into the closest extended screen 
remaining on Dashboard.

3. Choose the display size you want.

n Choose Full Size if you want to display the extended screens at their full-screen view size.

n Choose Compact if you want to display the extended screens as a mini icon.

To switch screens, click on the appropriate box in the mini icon.

4. Click one of the background options to select a different background for your extended screens.

n Choose one of the Predefined backgrounds if you want to use one of Dashboard's backgrounds. 

n Choose Use Windows background if you want to use the current Windows background. 

n Choose Bitmap and click Browse if you want to search for a bitmap file on your system.

5. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

See Also
Extended Screens Preferences
Using Custom Dashboard Configurations



Setting Hotkeys Preferences for Extended Screens
You can assign a hotkey to each extended screen on Dashboard. These hotkeys let you use the keyboard
to switch between extended screens.

1. Double-click the right mouse button on one of the extended screens to open the Customize dialog 
box with the Extended Screens Preferences.

If the Extended Screens are not currently displayed on Dashboard, click the Customize button and 
then click Extended Screens in the list.

2. Click the Hotkeys tab.

3. Enter a hotkey for each extended screen.    

To enter a hotkey, click in the hotkey box and press the key combination you wish to set.

You can enter a function key (for example, F4) or a number, letter, or character key. If you enter any 
key other than a function key, Dashboard inserts the Ctrl and Alt keys in front of your key. If you enter 
a key combination that is used in another application, the corresponding function in that application 
will override the Dashboard hotkey.

If you want to clear the existing Hotkey, click in the Hotkey box and press Del or Backspace.

4. Click Done.

See Also
Setting Hotkey Preferences for Dashboard
Using Dashboard Keyboard and Mouse Shortcuts
Using Custom Dashboard Configurations



Setting Sticky Apps Preferences for Extended Screens
1. Launch the application you want to designate a Sticky App.

2. Double-click the right mouse button on one of the extended screens to open the Customize dialog 
box with the Extended Screens Preferences.

If the Extended Screens are not currently displayed on Dashboard, click the Customize button and 
then click Extended Screens in the list.

3. Click the Sticky Apps tab.

4. Click Add.

5. In the Add Sticky App dialog box, click the program you want to designate as a Sticky App.

6. Click OK.

7. In the Customize dialog box, click Done.

See Also
The Add Sticky App Dialog Box
Using Custom Dashboard Configurations



Setting Main Preferences for Resources
You can use the main resource Preferences to customize the Resource Gauge and to set alarms for 
memory and System Resource levels.

Modifying the Resource Gauge
Dashboard includes an alarm that warns you when the total free memory or your Windows System 
Resources are getting low. You can determine the levels at which you want Dashboard to sound an 
alarm when either total free memory or Windows System Resources reaches a certain point.

1. Double-click the right mouse button on the Resource Gauge to open the Customize dialog box with 
Resource Main Preferences.

If the Resource Gauge is not currently displayed on Dashboard, click the Customize button and then 
click Resources in the list.

2. Enter exact kilobytes to set an alarm level for free System Memory.

3. Enter a percentage to set an alarm level for available System Resources (memory set aside for 
Windows).

4. Click the alarm sound drop-down list to choose a sound for the alarm.

If you did not install the Sound Driver for PC-Speaker, you cannot set a sound for the alarm.    For 
instructions on installing the driver, see your Dashboard Owner's Handbook.

5. Click Play Sound to hear a sample of the sound.

6. Choose the Display system memory odometer option if you want to display the memory odometer on 
Dashboard.

7. Choose the Display system resource gauge option if you want to show the resource gauge on 
Dashboard.

8. Choose Fuel Gauge or Bar Gauge from the Gauge Type drop-down list to configure the resource 
gauge display.

9. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

See Also
Resource Main Preferences
Using Custom Dashboard Configurations



Setting Drive Watch Preferences for Resources
You can use the main resource Preferences to customize the Resource Gauge and to set alarms for 
memory and System Resource levels.

1. Double-click the right mouse button on the Drive Watch panel to open the Customize dialog box.

If the Drive Watch panel is not currently displayed on Dashboard, click the Customize button, click 
Resources in the list, and then click the Drive Watch tab.

2. To add a drive to the Drive Watch panel, click that drive in the list and click Add.

3. To remove a drive from the Drive Watch panel, click that drive in the list and click Remove.

4. To display the Drive Watch panel on Dashboard, choose the Display drive watch window option.

If the Drive Watch panel is currently displayed and you want to hide it, deselect the option.

5. To update the Drive Watch information, click Refresh.

6. To save the changes and close the dialog box, click Done.

If you don't want to keep the changes, click Undo.

See Also
Resource Drive Watch Preferences
Using Custom Dashboard Configurations



Launching Programs with a Program Window
You can launch any program from a Dashboard program window.

1. Double-click the program group you want to open on the Program Menu.

2. Double-click the icon for the program you want to launch.





About Button
The About button shows information about Dashboard, including the product number, 
product version number, and copyright information.



Alarm Clock and Calendar
The Alarm Clock shows the date and time set on your computer. When you start Dashboard, 
the Calendar shows you the current month, with the current date highlighted. You can click 
the scroll buttons to view past and future months. Hold down the Shift key and click the 
scroll buttons to scroll forward or back a year at a time.    Double-click the clock or single-
click a calendar date to add or edit an alarm and to configure the way the clock and calendar
look.
You can customize the clock face to be analog or digital. You can change the appearance of 
either the analog or digital clock, and you can turn off the second hand on the analog clock. 
You can also display the current date and time on the Dashboard title bar. You can customize
the highlight colors for the current date and for days with assigned alarms. You can also set the 
amount of time for the alarm's snooze interval.

See Also
Customizing the Alarm Clock 
Setting an Alarm 



Customize Button
The Customize button is the button with a wrench icon.    Use the Customize button to 
personalize different features of Dashboard and set the preferences for different items on 
Dashboard. You can use the Customize dialog box to change the positions of items on 
Dashboard, and you can choose whether to show or hide particular items.    You can specify 
the fonts and colors to be used in the Dashboard window.    You can configure Dashboard to 
run as a shell program and set hotkeys and mouse buttons to toggle Dashboard in front of 
and behind other windows. You can save specific configurations of Dashboard in files and 
load those configurations as needed.
See Also
The Customize Dialog Box 



Extended Screens
Using Dashboard with its extended screens is like connecting your computer to several side 
by side monitors. Although you work with only one monitor at a time, you open programs on 
all the monitors, and then switch back and forth among them to work with the different 
programs. Dashboard's extended screens contain miniature windows corresponding to the 
open program windows, displaying the icons and titles of programs in those windows.
The extended screens are completely interactive with the full-screen views. If you move or 
resize a program window on the full screen, the mini-window moves and resizes in a 
corresponding way.    If you bring one program to the front of another, the mini-windows on 
the extended screens will reflect the change. Also, if you move mini-windows on the 
extended screens, the programs they represent will move on the full screen.
To switch back and forth among different programs, click the selector button under the 
extended screen showing the window you want to view or double-click the extended 
screen's background. You can also configure a hotkey for each screen in the Extended 
Screens Preferences. You can designate programs to be "Sticky Apps" so that they are 
always displayed, regardless of which extended screen you are in.
To move open windows among the extended screens, drag the mini-windows in the 
Dashboard extended windows, or move the full-sized windows by dragging on the title bar.
You can launch programs by dragging them to an extended screen. You can drag programs 
from the Quick Launch panel, the Program Menu or a program window, the File Manager, or 
the Command Prompt in the Run dialog box.
See Also
Customizing Extended Screens 
Managing Extended Screens 
Launching Programs by Dragging 



Help Button
Use the Help button to find the help you need.
Click once on the Help button and the cursor becomes a question mark. Put the question 
mark on any item on Dashboard and click there to see specific help for that item.
Double-click the Help button to see an index of help topics. Click a topic to see the 
instructions you want or click the Search button to locate a particular word or phrase.



Layout Menu
Use the Layout Menu to name, save, and load custom layouts or to edit existing layouts.    
When you save a layout, Dashboard saves all the programs currently running, as well as 
their size and position on the extended screens.
See Also
Creating Layouts 
Editing Layouts 
Loading Layouts  
Managing Layouts 



Maximize Button
The Maximize button extends Dashboard horizontally to its full width. When you click the 
Maximize button, any panels which are expandable increase in size to use more space in 
Dashboard.    Expandable panels are displayed with scroll arrow buttons to indicate that 
more items exist than are currently shown.
If none of the current Dashboard panels are expandable, Dashboard does not change its 
size. If Dashboard is already maximized, this button returns it to its previous width. 
You cannot resize Dashboard if it is maximized.    You need to click the Restore button to 
return Dashboard to its original size.



Restore Button
When you have maximized the Dashboard window with the Maximize button, you can click the Restore 
button to restore Dashboard to its original size.



Minimize Button
The Minimize button reduces Dashboard to an icon.    You can customize the minimized icon 
using the Customize dialog box.    You can choose between the standard Dashboard icon, a 
clock icon, a resources icon, and an extended screen icon.



Printer Manager
The Printer Manager controls printers, fax machines, and plotters. To print or fax a file, drag 
the file onto the desired printer icon. You can drag a file from the File Manager, the Program 
Menu or Program Menu toolbar, a program group window, the Quick Launch panel or toolbar,
or the Command prompt in the Run dialog box. 
Click a printer icon to see the full name and description. Double-click to see the Printer 
Configuration box. Change the necessary configuration settings then click OK to save the 
changes.    The Customize dialog box lets you customize the Printer Manager; for example, 
you can change the Printer Manager display so that it shows the paper orientation of each 
printer.

Choosing a default printer
The green light (or "on" light if you don't have a color monitor) denotes the default printer. 
To choose a different default printer, click on the default printer light.

Scrolling in the Dashboard to see other printers
If Dashboard is not wide enough to display all printers, the Print Manager portion of 
Dashboard will include scroll arrows. Click the scroll arrows to see printers that aren't 
currently visible.

Installing new printers
The Printer Manager offers a quick and easy way to handle all your installed printers. 
However, the Printer Manager does not install printers. To install a new printer, use the 
Windows Control Panel. Refer to your Windows documentation for more information.
The printer icon on Dashboard reflects the orientation of the printer (portrait or landscape).   
If you change the orientation setting in the Printer Configuration box, the icon will change 
also.

Rearranging Printers on Dashboard
You can move a printer within the Printer Manager by dragging it to a new position.

See Also
Customizing the Printer Manager 



Program Menu
The Program Menu lists the program groups in the Windows Program Manager. 

Click a program menu button on the Program Menu to see an alphabetical list of the programs in the 
program group. To launch a program, click the program item in the list or drag it to an extended screen.

You can choose the order in which groups appear in the Program Menu, and you can also add new 
groups, modify and delete selected groups, and open a program window for a group.
If you want to display the Program Menu as a floating window separate from Dashboard, you
can configure the Program Menu to be displayed as a Program Menu toolbar. You can use the
Program Menu in the same way whether it is on Dashboard or configured as a Toolbar. Any 
changes you make to the toolbar will appear in the Program Menu when you close the 
toolbar.
See Also
Managing Program Groups with the Program Menu
Managing Program Groups with Program Windows 
Customizing the Program Menu 



Quick Launch Buttons
You can create a set of Quick Launch buttons for the programs you use most often. Once a 
program has been assigned to a Quick Launch button, you can click the button to run the 
program. You can also launch a program by dragging its Quick Launch button to one of the 
extended screens.
To change Quick Launch preferences in the Customize dialog box, double-click the right 
mouse button on any of the Quick Launch buttons.    With the Quick Launch Preferences, you 
can create new Quick Launch buttons, modify or delete existing buttons, choose from three 
button styles, and change the position of the buttons on Dashboard. You can create a Quick 
Launch toolbar if you want to display the Quick Launch panel as a snap-off panel separate 
from Dashboard. Any changes you make to the Quick Launch panel will be reflected in both 
the Quick Launch panel on Dashboard as well as on the Quick Launch toolbar.
You can rearrange the Quick Launch buttons on Dashboard or on the Quick Launch toolbar 
by dragging a button to a new position. If you want to copy a Quick Launch button, hold 
down the Ctrl-key and press the mouse on the button, then drag the copy to a new position 
on the panel.
See Also
Customizing Quick Launch Buttons 



Resource Gauge
You can use the Resource Gauge and the Memory Odometer to check the levels of total free 
memory and Windows System Resources on your system.    The Resource Gauge shows the 
level of Windows System Resources currently available on your system. 
Each application you open uses System Resources memory.    If the level of System 
Resources gets too low, you may not be able to open new applications. The Warning 
Indicator blinks and sounds an alarm as you reach the alarm level for either available free 
system memory or system resources. You can double-click the Resource Gauge to see a list 
of all applications currently running on your system; if you need more memory or resources, 
close one or more of these applications.
The Memory Odometer shows the total amount of free system memory in kilobytes. You can 
configure the Resource Gauge to show or hide the Memory Odometer. You can also display 
the Resource gauge as a fuel gauge or a bar gauge. 
See Also 
Checking Your Resources 
Customizing the Resource Gauge 



Show Program Menu Button
Click this button to show or hide the Dashboard Program Menu, which lists program groups.
The Show Program Menu Button is not available when you are running Dashboard in the 
vertical orientation or when you are running the Program Menu as a toolbar.    In either of 
these configurations, use the Customize dialog box to show or hide the Program Menu 



Sizing Bar
You can use the Sizing Bar to change the size of the Dashboard window. The Sizing Bar 
comprises all four borders of the window. When you position the cursor over a Sizing Bar, the
cursor becomes a two-headed arrow. You can drag the Sizing Bar in the appropriate direction
to change Dashboard's width or height.
When Dashboard is in its horizontal orientation, you can change Dashboard's height by dragging the 
window's top or bottom border. The window size is limited by the number of items on Dashboard that can 
be expanded or hidden from view.    For example, if the Dashboard window only has one printer icon and 
one Quick Launch button, there's probably no reason to resize.    But if your computer has multiple 
printers, you may have to resize it to display all the printers. You cannot make Dashboard bigger than is 
necessary to display all items adequately.

When Dashboard is in its vertical orientation, you can change Dashboard's width by dragging the 
window's left or right border.

Enlarging Dashboard may cause some of its panels (such as the panels for the printers or the Quick 
Launch buttons) to be too big to show all of their items.    When that happens, panels on the left (on the 
top in the vertical orientation) will have priority over panels on the right (on the bottom in the vertical 
orientation).    For example, if the Quick Launch panel is to the left of the printers' panel, more Quick 
Launch buttons will be visible than printers.    You can use the scroll arrows to see the other printers, or 
you can resize the printer panel by holding down the Shift key and dragging the panel borders.



System Menu
The System Menu includes standard Windows System menu commands for working with the 
window, as well as Dashboard commands to switch to other Dashboard menus.



Task Menu
The Task Menu switches among currently open programs.    You can also use the Task menu 
to display an open program on the current extended screen, run new programs, and close all
programs other than Dashboard, the Program Manager, and DOS applications.
You can synchronize your extended screens to correspond to the currently open program 
windows by using the Update Screens command on the Task menu.



Title Bar
The Title Bar displays the window caption and can also show the current date and time or 
information about your system resources, depending on the option you choose in the 
Customize dialog box. You can also change Dashboard's font, and the change will be 
reflected in the Title Bar. Click and drag the title bar to move the entire Dashboard.



Drive Watch
The Drive Watch panel displays disk space information for the selected drives on your system.    You can 
add or remove drives from the display by using the Drive Watch setting in the Resources Drive Watch 
Preferences.





The Alarm Settings Dialog Box
The Alarm Settings dialog box lets you specify information about an alarm. Specify options for how and 
when the alarm should sound, and then click OK.

Here is a description of the options you can use to define an alarm:

Time:    To set the time for the alarm to sound, select the hour and minutes and enter new values. Choose
whether time set is AM or PM.

Alarm Text:    Enter the text here that you want to appear with the alarm message.

Show Alarm: Specify whether you want the alarm to go off on a regular basis or once only.

n Choose Recurring and select a day if you want the alarm to go off on the same day of every 
week.

n Choose Date and enter the specific day, month, and year if you want the alarm to go off only 
once. Enter the date in the format DD/MM/YY. You can also click the up and down arrow buttons 
to change the date. 

Optional Alarm Actions:    To set the alarm to launch a program, enter the program's name and current 
working directory. Check the box to have the program opened as minimized. Click Browse to see the 
command lines and working directories for your files. When the alarm goes off, Dashboard will 
automatically open that program in addition to displaying the Alarm Text you entered.

Sound:    Choose the alarm's sound from this pull-down menu. To hear a sound, select it in the list and 
click Play Sound.

If you did not install the Sound Driver for PC-Speaker, you cannot hear sound with the alarm.    For 
instructions on installing the driver, see your Dashboard Owner's Handbook.



The Clock Alarms Dialog Box
The Clock Alarms dialog box shows all the alarms you've already defined. Double-click any alarm to see 
details. Use buttons to add new alarms or change existing alarms.

Add:    Adds a new alarm.

Edit:    Edits an alarm; click the alarm you want to change and click either the Edit or Delete button.

To customize your clock preferences (including the time interval for the Snooze feature), click the 
Configuration button.

See Also
Customizing the Alarm Clock 
Setting an Alarm 



The Customize Dialog Box
Use the Customize dialog box to choose which items to display on Dashboard and the order in which they
should appear.

The list on the left includes all the Dashboard panels. Click any item, and the right side of the dialog box 
displays the preferences for that item.    Choose the new options you want and you'll see the changes on 
Dashboard.    To keep the changes, click Done and the dialog box will close.    Your changes will be put 
into effect.    If you don't want to keep the changes, click Undo, and the Dashboard will appear as before.

Choosing which items to include in your Dashboard
To exclude any item from Dashboard, click the item and click the Hide button. The text "not shown" will 
appear next to the item to indicate that it is not currently included in Dashboard.

To add any item that was previously hidden, click the item and click the Show Item button.

Reordering the items in your Dashboard
The list of Dashboard items includes a line separating them into two groups. You can reorder items below 
this line by dragging it to a new position in the list. The top-to-bottom sequence corresponds to their left-
to-right sequence in Dashboard when it is in the horizontal position.

Using custom Dashboard configurations
The File Menu in the Customize dialog box lets you configure Dashboard to suit particular tasks and save 
each configuration as a file for future use.    Later on, when you have to get that task done, you can load 
the custom Dashboard configuration for it.

To save a configuration, choose Save or Save As from the File Menu.

Save saves the current configuration into the configuration file currently being used.    The caption of the 
Customize dialog box shows the name of the current file.    Use Save As to save to a different file name.

In the Save As dialog box, enter the path and file name for the file in the text box.    A .cfg extension is 
automatically added to the new file name, and the current configuration file now changes to the new file 
name.    Click OK to save the file.

Getting help
To get help on any of the preferences, click the item in the list.    The preferences for that item appear in 
the right side of the dialog box.    Choose Help from the Help menu to see instructions for working with the
preferences.



Dashboard Colors Preferences
You can choose a custom color scheme for the Dashboard window and any toolbars. You can also 
display the window and toolbars in Dashboard's default colors or in gray-scale.

n To display Dashboard in a custom color scheme, click the appropriate color box.

n To display Dashboard in the program's default color scheme, choose the Default Colors check 
box.

n To display Dashboard on a gray-scale monitor, choose the Gray-Scale Colors check box.

See Also
Using Custom Dashboard Configurations 
Using Toolbars 



Program Menu Preferences
To work with Program Menu Preferences, click Program Menu in the list on the left side of the Customize 
dialog box.

Choosing whether to include the Program Menu on the Dashboard
To remove the Program Menu from Dashboard, click Program Menu from the list on the left and click Hide
Item.

If the Program Menu has been removed from Dashboard, the list on the left will indicate that the Program 
Menu is "not shown." To restore the Program Menu on Dashboard, click Program Menu from the list on 
the left and click Show Item.

Modifying a program group's color key or description
1. Click a group in the Program Groups list.

2. Click Modify.

3. Enter a new group description or select a new color key setting.

The group description you enter will appear on the Dashboard program menu button.

Creating a new program group
1. Click New.

2. Enter a group description and select a color key setting.

The group description you enter will appear on the Dashboard program menu button.

3. If you want, enter a file name for the group.    The file name setting is optional.

Deleting a program group from the Dashboard
1. Click a group in the Program Groups list.

2. Click Delete.

Rearranging program groups
Click the program group you want to move in the list and drag it to its new position in the list. The 
Program Menu button for that group will be moved appropriately on the Program Menu.

Opening a Group into a Group Window
1. Click a group in the Program Groups list.

2. Click Open.

Specifying a height for the Program Menu
Use the Show 2nd row of text option to display two rows of text on the Program Menu buttons..

Hiding a group on the Program Menu
1. Click a group in the Program Groups list.

2. Click Hide Group.

Choosing whether to display colors in the Program Menu
Each program group can include a color to make it more identifiable. Use the Show Color Keys option to 
turn colors on in the Program Menu.



Updating Dashboard with changes made in the Windows Program Manager
Click the Reread from Program Manager button.

Changes you make to groups with the Program Manager while Dashboard is running will not be reflected 
in the Dashboard groups until you click this button. If you close Dashboard and then run it again, the 
changes will also take effect.

Canceling changes to Dashboard preferences
To cancel any changes you have made in the Customize dialog box, click the Undo button.



Quick Launch Preferences
You can use Quick Launch preferences to add, edit, or delete a Quick Launch button. You can also assign
a shortcut key to each Quick Launch button and customize the appearance of the buttons.

Choosing whether to include Quick Launch buttons on the Dashboard
To remove the Quick Launch buttons from Dashboard, click Quick Launch from the list on the left and 
click Hide Item.

If the Quick Launch buttons have been removed from Dashboard, the list on the left will indicate that 
Quick Launch is "not shown." To restore the Quick Launch buttons on Dashboard, click Quick Launch 
from the list on the left and click Show Item.

Adding a new Quick Launch button
1. Click New.

2. Enter a title for the button.

3. Enter the correct command line (path name and filename of the program you want to run) and 
working directory for the program. Click Browse if you don't know the path name for the program.

4. Choose the Run Minimized option if you want the program to be minimized when you open it.

5. If the program includes an icon file, its default icon appears on the Quick Launch button. Click 
Change Icon to change the program icon.

Assigning a shortcut key to a Quick Launch button
1. Click in the Shortcut Key box.

2. Press the key combination on the keyboard.

You can enter a function key (for example, F4) or a number, letter, or character key. If you enter any 
key other than a function key, Dashboard inserts the Ctrl and Alt keys in front of your key. 

If you want to clear the existing shortcut key, click in the Shortcut Key box and press Del or 
Backspace.

If you use this shortcut key when you have a full-screen DOS application running, Dashboard will not 
launch the application associated with the shortcut key.    If the application is already running, 
Dashboard will bring the window to the front of the desktop.

Deleting a Quick Launch button
1. Click the Quick Launch button you want to delete.

2. Click Delete.

Editing a Quick Launch button
1. Click the Quick Launch button you want to change.

2. Make any changes you want, including the title, command line, working directory, icon, shortcut key, 
and whether the program should run minimized.

Rearranging Quick Launch Buttons
Click the Quick Launch button you want to move in the list and drag it to its new position in the list. 

Assigning a button style
Choose one of the three available styles for the button.

n Choose Unlabeled to display only icons on the buttons.



n Choose Labeled to display icons and application names on the buttons.

n Choose Mini to display miniature buttons with icons. 

Canceling changes to Quick Launch preferences
To cancel any changes you have made in the Customize dialog box, click the Undo button.



Clock and Calendar Preferences
You can use the Clock and Calendar Preferences to customize the appearance of the clock and calendar,
or to hide either panel.

Choosing whether to include the Clock or Calendar on Dashboard
To remove the Clock and Calendar from Dashboard, click Clock/Calendar in the list on the left and click 
Hide Item. To remove the Clock only, deselect the Show Clock option in Clock Preferences.    To remove 
the Calendar only, deselect the Show Calendar option in Calendar Preferences.

If the Clock and Calendar have both been removed from Dashboard, the list on the left will indicate that 
the Clock is "not shown." To restore both the Clock and Calendar, click Clock/Calendar in the list on the 
left and click Show Item. To restore the Clock only, choose the Show Clock option in Clock Preferences.    
To restore the Calendar only, choose the Show Calendar option in Calendar Preferences.

Customizing the clock
1. Click a Clock Type option. Analog clocks show time with minute and second hands pointing to 

numbers, and digital clocks represent time as a number.

2. Click to open the Clock Face Menu, and choose an option to specify the appearance of the clock you 
want.

3. If you are using an analog clock, choose the Second Hand option to display a second hand on the 
clock.

The second hand may interfere with some communication programs.    If your communication 
program is experiencing unnecessary time-outs, try turning off the Second Hand option.

4. Next to Snooze Interval, type the number of minutes in which you want the alarm to reappear after 
you click the Snooze button in an alarm message.

Customizing the Calendar
1. To select a highlight color for the current date, click on the appropriate color under Today.

2. To select a highlight color for days with assigned alarms, click the appropriate color under Alarms.

3. If you don't want any highlight colors displayed on the calendar, choose the No HIghlights option.

4. To display the current date on the calendar, click Go to Today.

Canceling changes to Clock/Calendar preferences
To cancel any changes you have made in the Customize dialog box, click the Undo button.

See Also
Using Custom Dashboard Configurations 



Extended Screens Main Preferences
You can use the Extended Screens Main preferences to customize the appearance of the screens.

Choosing whether to include the extended screens on Dashboard
To remove the extended screens from Dashboard, click Extended Screens from the list on the left and 
click Hide Item.

If the extended screens have been removed from Dashboard, the list on the left will indicate that the 
extended screens are "not shown." To restore the extended screens on Dashboard, click Extended 
Screens from the list on the left and click Show Item.

Specifying the number of extended screens
Click an option to choose the maximum number of extended screens. 

If a number is grayed out, there is not enough room on Dashboard for that many extended screens. To 
make more room on Dashboard, remove items from Dashboard by clicking on one of the Dashboard 
items listed in the Customize dialog box.    You can then select a larger number of extended screens to 
display.

If you decrease the number of extended screens on Dashboard, any applications contained in the 
removed extended screens (the left or right screens) are moved into the closest extended screen 
remaining on Dashboard.

Choosing a display size for the extended screens
Choose one of the two size options for the extended screens.

n Choose Full Size if you want to display the extended screens at their largest possible size.

n Choose Compact if you want to display the extended screens as a mini icon.

Specifying the background color for the extended screens
Click one of the background options to select a different background for your extended screens.

n Choose one of the Predefined backgrounds if you want to use one of Dashboard's backgrounds. 

n Choose Use Windows background if you want to use the current Windows background. 

n Choose Bitmap and enter the name of the bitmap file you want to use.

If you want to search for a bitmap file on your system, click Browse.

Canceling changes to Extended Screens preferences
To cancel any changes you have made in the Customize dialog box, click the Undo button.

See Also
Using Custom Dashboard Configurations 



Printer Manager Preferences
To work with Printer Manager Preferences, click Printer Manager in the list on the left side of the 
Customize dialog box.

Displaying a printer's paper orientation on the Printer Manager.
Choose the Show paper orientation check box.

Choosing whether to include the Printer Manager on Dashboard
To remove the Printer Manager from Dashboard, click Printer Manager from the list on the left and click 
Hide Item.

If the Printer Manager has been removed from Dashboard, the list on the left will indicate that Printer 
Manager is "not shown." To restore the Printer Manager on Dashboard, click Printer Manager from the list
on the left and click Show Item.

Showing and hiding a printer
To remove a printer from the Printer Manager, click the printer and click Hide Printer.

If a printer has been removed from the Printer Manager, the list will indicate that the printer is "not shown."
To restore the printer on the Printer Manager, click the printer from the list and click Show Printer.

Rearranging printers
For the list of printers in the Printer Manager, the top-to-bottom sequence corresponds to their left-to-right 
sequence in Dashboard horizontal orientation and to their top-to-bottom sequence in the vertical 
orientation.

To change a printer's position, drag it to a new place in the list.

Choosing a default printer
1. Click the printer you want as the default printer.

2. Click Set As Default.

Changing a printer's description and icon
1. Click the printer you want to change.

2. Type a description you want to be displayed with the printer icon on Dashboard.

3. Click Change Icon to choose a new printer icon to be displayed for this printer.

Changing the setup of a printer
1. Click the printer you want to change.

2. Click Setup.

3. Use the Windows dialog boxes to change the printer's setup. Refer to the documentation for Windows
and for your printer for more information about setup options.

Canceling changes to Printer Manager preferences
To cancel any changes you have made in the Customize dialog box, click the Undo button.

See Also
Using Custom Dashboard Configurations 



The Edit Layout Dialog Box
The Edit Layout dialog box lets you change the specifics of a selected program.    The information you see
in this box was saved automatically by Dashboard when you created the layout.    After you make your 
changes, Dashboard will use this information to run programs when you use the Load Layout command.

Editing program specifics
1. Enter a name for the program in the Application Name box.    This name is a descriptive name, not a 

filename.

2. Enter the working directory in the Working Directory box.

3. If you want a particular file instead of just the program to open as part of a layout, enter the filename 
in the Parameters box.

4. Choose a size for the program window from the Window Size pull-down menu. You can choose 
Normal, Minimized, or Maximized for the window size.

5. To exit the Edit Layout dialog box and save any changes, click OK.

6. To exit the Edit Layout dialog box without saving changes, click Cancel.



The Manage Layouts Dialog Box
The Manage Layouts dialog box lets you edit existing layouts.

Removing a Layout
1. Select the layout in the Layout list.

2.  Click Delete Layout.

Changing the name of a layout
1. Select the layout in the Layout list.

2. Click Rename.

3. Enter the new name in the Rename dialog box and click OK.

Removing a program from a layout
1. Select the program in the Applications for Layout list.

2. Click Delete.

Editing a program's specifics
1. Select the program in the Applications for Layout list.

2. Click Edit.

3. Enter the appropriate information in the Edit Layout dialog box.

Exiting the Manage Layouts dialog box
1. To exit the Manage Layouts dialog box and save any changes made, click Save Changes.

2. To exit the Manage Layouts dialog box without saving changes, click Cancel.



The Resources Dialog Box
The Resources dialog box contains information about your total free memory and Windows System 
Resources.    Use the Resources dialog box to look at resource usage and to set alarm levels for low 
resources.    

The list on the left includes all types of resource and system information you can view and work with. 
Click any item; the right side of the dialog box displays information for that item.

To print a selected item from the dialog box, click the Print button.    Dashboard will print a copy of the 
information on your default printer.

For instructions on using any of the specific sections in the dialog box, click one of the following topics:

Memory and Resources 
System Environment 
Drive Usage 
Applications Running 
Environment Variables 



Memory and Resources
The Memory and Resources information tells you about your total free memory and Windows 
System Resources.    

1. To display Memory and Resources information, click Memory and Resources in the list on the left of 
the Resources dialog box.

2. Type exact kilobytes to set an alarm level for System Memory (the total free memory for your 
computer.)

3. Type a percentage to set an alarm level for System Resources (memory set aside for Windows). 

4. Select a sound for the alarm.

5. To display the System Resource gauge, choose the Display System Resource gauge option.

6. To choose a gauge type, click the Gauge Type drop-down list and choose bar gauge or fuel gauge.

7. To display the System Memory Odometer, choose the Display System Memory Odomter option.

8. To print Memory and Resources information, click the Print button.    Dashboard will print a copy of the
information on your default printer.



System Environment
1. To display System Environment information, click System Environment in the list on the left of the 

Resources dialog box.

System Environment lists information such as CPU type, monitor type, mouse, keyboard, network, 
output port, and output devices installed under Windows.

2. To print System Environment information, click the Print button.    Dashboard will print a copy of the 
information on your default printer.



Drive Usage
1. To display disk space information, click Drive Usage in the list on the left of the Resources dialog box.

Drive Usage shows information about available disk space for each one of the drives on your 
computer.    The information includes floppy drives, hard disk drives, network drives, total disk space, 
used disk space, and available disk space.

2. To add a drive to the Drive Watch panel, select the drive in the drive list and click Add.

3. To remove a drive from the Drive Watch panel, select the drive in the drive list and click Remove.

4. To specify how frequently Dashboard updates the Drive Watch information, enter the number of 
seconds in the Update Interval box.

5. To display the Drive Watch panel on Dashboard, select the Display drive watch window checkbox.

6. To have Dashboard update the disk space information for all drives, click Refresh.

7. To print Drive Usage information, click the Print button.    Dashboard will print a copy of the information
on your default printer.



Applications Running
1. To display information about applications that are currently running, click Applications Running in the 

list on the left of the Resources dialog box.

A list of all currently running applications and their memory usage is displayed.    The list is sorted 
according to the amount of memory used by each application.    

2. To update the list of applications, click the Refresh button.

3. To free memory by closing an application, select it in the list, then click Close Application.

4. To print information about the currently running applications, click the Print button.    

5. To view more information about a specific application, select the application and click More.

The Application Task Information dialog box opens, displaying a detailed breakdown of the 
application's memory usage.

Dashboard will print a copy of the information on your default printer.



Environment Variables
1. To display environment variables information, click Environment Variables in the list on the left of the 

Resources dialog box.

Refer to Windows documentation and to your application's documentation for more information about 
the environment variables you need.

2. To print environment variables information, click the Print button.    Dashboard will print a copy of the 
information on your default printer.



The Dashboard Run Dialog Box
You can use the Dashboard Run dialog box to perform DOS commands or to launch programs. You can 
also use the Dashboard Hotkeys Preferences to set a hotkey to open the Run dialog box.

Performing DOS commands with the Command Line
1. Enter a DOS command in the Command Line box.

or

Click the arrow on the Command Line box to see the last 20 DOS commands used. If the command 
you want to use is displayed, select the command.

2. Press Enter.

Performing DOS commands at the command prompt
1. Enter a DOS command at the command prompt.

or

Press Shift-F8 to move the keyboard focus into the past commands, then click the scroll arrows to 
scroll up and down through the commands and click the command you want to use.

2. Press Enter.

Launching a program
1. Double-click on the Task menu or choose Dashboard Run from the Task menu to open the 

Dashboard Run dialog box.

2. Choose the Run Minimized option if you want the program you're launching to be minimized when 
you open it.

3. Launch the program you want to use.

n In the Command Line box or the Command Prompt box, enter the command line for the program 
to run and click Run. 

If you don't know the command line, click the Browse button or enter DOS commands in the 
Command Prompt box to locate the program file.

or

n If the Command Prompt box already contains the program's executable file, double-click on the 
file or drag it to an extended screen.

or

n Click the arrow on the Command Line box to see the last 20 DOS commands used. If the 
program's executable file is displayed, select the file and click Run.

See Also
Using the Command Prompt 
Setting Hotkeys Preferences for Dashboard



The Save Layout Dialog Box
The Save Layout dialog box lets you save all the programs currently running in their current positions on 
the extended screens.

1. Enter a name for the layout in the Layout box.

The Programs box lists all the programs that will be included in the layout.

2. If you want to launch all the layout's programs when you start Dashboard, choose the Load layout on 
startup option.

3. To edit the program's command line parameters and working directory set up by the layout, select a 
program from the list and click Edit.

Make the appropriate changes in the Edit Layout dialog box.

4. To remove a program from a layout, select it from the list and click Delete.

5. To save the current layout, click OK.

6. To exit the Save Layout dialog box without saving changes, click Cancel.

See Also
Using Custom Dashboard Configurations 



The Printer Manager Change Icon Dialog Box
1. Click the icon you want to use for this printer. Scroll through the box if you want to see more icons.

2. Click OK.



The Quick Launch Change Icon Dialog Box
1. If multiple icons are displayed in the Current Icon box, click the icon you want to use.

2. Change the File Name if the icon you are looking for is associated with a different file. Changing the 
file here will not change the file used to launch this program.

3. Select the icon from the box.    Scroll through the box if you want to see more icons.

4. Click OK.



The Browse Dialog Box
1. Under List Files of Type, use the pull-down menu to choose the types of files you want to find.

2. To choose more specific types of files, type their file extensions in the text area under File Name. For 
example, to look for files with .txt and .doc extensions, type    *.txt; *.doc.

3. Under Drives, use the pull-down menu to choose the drive where you want to look for files.

4. Under Directories, double-click to open directories and browse for files. When a directory is opened, 
files matching the current file names will be displayed in the list on the left.

5. When you find the file you're looking for, double-click it or select it, then click OK.

The selected path and file name are displayed in the Command Line field in the Customize dialog 
box.



The Dashboard Task Manager
The Dashboard Task Manager lets you switch between currently running applications or close selected 
applications. It also contains a list of applications that are minimized. You can also use the Task Manager 
to arrange open windows in the extended screens.

Switching to another applications.
1. Select the application in the Task List

2. Click Switch To.

Closing an application
1. Select the program in the Task List.

2. Click Close Selected.

Displaying memory usage information for a program
1. Select the program in the Task List.

2. Click Task Info.

Displaying all extended screen windows in a Tile arrangement.
n Click Tile.

Displaying all extended screen windows in a Cascade arrangement
n Click Cascade.

Rearranging minimized icons
n Click Arrange Icons.

Closing the dialog box
n Click Done.



The Save Configuration File Dialog Box
You use the Save Configuration File dialog box to save the current Dashboard configuration to a new file 
name.

1. Enter the path and file name for the file in the File Name box.

2. Click OK.

3. Click Done in the Customize dialog box.



The Load Configuration File Dialog Box
You use the Load Configuration File dialog box to load a selected configuration file.    Dashboard will be 
displayed according to the settings in the new configuration file.    

1. Enter the path and file name for the file in the Directories and File Name fields.    

2. Click OK.

The file you load becomes the default configuration file.    If you close Dashboard while this 
configuration file is active, Dashboard will save any configuration changes you have made to this file.



The Modify Program Group Dialog Box
You use the Modify Program Group dialog box to make changes to an existing Program Group.

1. Enter the new name of the group and select a color key setting.    You can also enter the name of the 
group file if you want.

2. Click OK.

3. Click Done.



The New Program Group Dialog Box
You use the New Program Group dialog box to add a Program Group.

1. Enter the name of the new group and select a color key setting.    You can also enter the name of the 
group file if you want.

2. Click OK.

3. Click Done.



Dashboard Main Preferences
You can use the Main preferences to set options for the main Dashboard window.

Specifying how to display the Dashboard
Choose the Dashboard always in front option if you always want Dashboard in front of all other windows. 
Otherwise, choose the F-Key you want to use to bring Dashboard into view.

Using Dashboard as a shell
Choose Use Dashboard as Windows Shell if you want Dashboard to be the first program to run (known as
the "shell program") instead of the Program Manager each time you start Windows.    

Using the Dashboard Task Manager
Choose Replace Windows Task Manager if you want to use Dashboard's Task Manager to switch 
between currently running applications.

Including program icons in the Dashboard
Choose the Show icons in menus and screens option to see program icons in Dashboard's extended 
screens, Program Menu, and Task Menu.

Choosing a Title Bar display
Choose one of the options in the Title Bar Display drop-down list to determine the appearance of the 
Dashboard's title bar. 

n Choose Standard to include only a title. 

n Choose Clock to include the date and time.

n Choose Resources to include system resources information.

Choosing an icon for the minimized Dashboard
Choose one of the options in the Minimized Display drop-down list to choose the icon to be displayed 
when the Dashboard is minimized. 

n Choose the standard Dashboard icon to display only a title.

n Choose Clock/Calendar to display the current date and time.

n Choose Extended Screens to display miniature extended screens.    If you choose the extended 
screens icon, you can switch screens by clicking on the little boxes in the minimized icon.

n Choose Resources to display system resources information.

Choosing an orientation for the Dashboard window
n Choose Horizontal if you want to display Dashboard in the horizontal orientation.

n Choose Vertical if you want to display Dashboard in the vertical orientation.

See Also
Using Custom Dashboard Configurations 



Dashboard Toolbar Preferences
Use the Toolbar Preferences to designate which Dashboard panels you want to display as toolbars.

1. In the Toolbars box, choose one or more of the three available panels.

2. If you want the toolbars to minimize when you minimize Dashboard, choose the Toolbars minimize 
with Dash check box.

See Also
Using Custom Dashboard Configurations 
Using Toolbars 



Dashboard Fonts Preferences
Use the Fonts preferences to choose the fonts displayed in the Dashboard window and any toolbars.

1. In the Font list, choose the font you want to use.

2. In the Font Size list, choose the point size you want to use.

3. In the Font Style list, choose the style you want to use.

4. To use Dashboard's default font, click Default Font.

See Also
Using Custom Dashboard Configurations 
Using Toolbars 



Dashboard Hotkeys Preferences
Use the Hotkeys preferences to assign a shortcut key and a mouse shortcut to activate Dashboard.    
When you use the shortcut key or the mouse shortcut, Dashboard comes to the front of any other 
windows or, if it is already displayed in front, goes to the back. You can also assign a shortcut key that will
open the Dashboard Run dialog box.

Assigning a shortcut key to activate Dashboard
1. Click in the Shortcut Key box.

2. Press the key combination on the keyboard.

You can enter a function key (for example, F4) or a number, letter, or character key. If you enter any 
key other than a function key, Dashboard inserts the Ctrl and Alt keys in front of your key. 

If you want to clear the existing shortcut key, click in the Shortcut Key box and press Del or 
Backspace.

Assigning a mouse shortcut to activate Dashboard
1. Click in the Mouse Shortcut box.

2. Click the mouse combination that you want to use.

You can use any mouse button combination with the left, middle, or right button, except a single- or 
double-click with the left button.

If you are running a full-screen DOS application, you cannot use the mouse shortcut to toggle 
Dashboard; you can only use the shortcut key.    Also, if you are using applications that do not support
a double-click operation, you should not set the mouse shortcut to a double-click.

Assigning a shortcut key to open the Dashboard Run dialog box
1. Click in the Dashboard Run box.

2. Press the key combination on the keyboard.

You can enter a function key (for example, F4) or a number, letter, or character key. If you enter any 
key other than a function key, Dashboard inserts the Ctrl and Alt keys in front of your key. 

If you want to clear the existing shortcut key, click in the Dashboard Run box and press Del or 
Backspace.

See Also
Extended Screen Hotkeys Preferences 
Using Custom Dashboard Configurations 
Using Dashboard Keyboard and Mouse Shortcuts 



Extended Screens Hotkeys Preferences
Use the Hotkeys preferences to assign a hotkey to each extended screen..

1. Click in the hotkey box for an extended screen.

2. Press the key combination on the keyboard.

You can enter a function key (for example, F4) or a number, letter, or character key. If you enter any 
key other than a function key, Dashboard inserts the Ctrl and Alt keys in front of your key. 

If you want to clear the existing shortcut key, click in the Shortcut Key box and press Del or 
Backspace.

See Also
Dashboard Screen Hotkeys Preferences 
Using Custom Dashboard Configurations 
Using Dashboard Keyboard and Mouse Shortcuts 



Extended Screens Sticky Apps Preferences
Use the Sticky Apps preferences to designate an application as a Sticky App.

Adding a Sticky App
1. Click Add.

2. In the Add Sticky App dialog box, select the application you want and click OK.

3. Click Done.

Deleting a Sticky App
1. Select the Sticky App you want to delete.

2. Click Delete.

3. Click Done.



The Add Sticky Apps Dialog Box
1. To add a Sticky App, select the application and click OK.

2. To close the dialog box without adding a Sticky App, click Cancel.



Resources Main Preferences
Use the Resources Main Preferences to change the appearance of the Resource Gauge and to set 
alarms for memory and System Resources levels.    You can also remove the Resource Gauge from the 
Dashboard window.

Choosing whether to include the Resources on Dashboard
To remove the Resource Gauge from Dashboard, click Resources in the list on the left and click Hide 
Item, or deselect the Display system resources gauge option.

To restore the Resources on Dashboard, click Resources from the list on the left and click Show Item, or 
choose the Display system resources gauge option.

Choosing when to sound an alarm for low resources
Next to Alarm, enter the number of kilobytes or the percentage of remaining memory at which you want 
Dashboard to sound an alarm.

Selecting a sound for the alarm
Choose the appropriate sound from the drop-down list.    To hear the sound, click the Play Sounds button.

If you did not install the Sound Driver for PC-Speaker, you cannot hear sound with the alarm.    For 
instructions on installing the driver, see your Dashboard Owner's Handbook.

Displaying the system resources gauge
Choose the Display system resources gauge option.

Displaying the system memory odometer
Choose the Display system memory odometer option.

Displaying the drive watch window
Choose the Display drive watch window option.

Canceling changes to Resources Main preferences
To cancel any changes you have made in the Customize dialog box, click the Undo button.

See Also
Using Custom Dashboard Configurations 



Resources Drive Watch Preferences
Use the Resources Drive Watch Preferences to add or remove drives from the Drive Watch panel, or to 
remove the Drive Watch panel from the Dashboard window.

Choosing whether to include the Drive Watch panel on Dashboard
To remove the Drive Watch panel from Dashboard, click Resources in the list on the left and click Hide 
Item, or deselect the Display drive watch window option.

To restore the Drive Watch panel on Dashboard, click Resources from the list on the left and click Show 
Item, or choose the Display drive watch window option.

Adding a drive to the Drive Watch panel
Click the drive you want to add in the list and click Add.

Removing a drive from the Drive Watch panel
Click the drive you want to remove in the list and click Remove.

Canceling changes to Resources Main preferences
To cancel any changes you have made in the Customize dialog box, click the Undo button.

See Also
Using Custom Dashboard Configurations 



The Application Task Information Dialog Box
The Application Task Information dialog box shows you memory information about the selected 
application in the Application Running dialog box or in the Task Manager. If you have more than one copy 
of an application running, the dialog box shows the task memory used by each copy, as well as the 
common memory shared by the copies.





Total Free Memory:    The total amount of memory available on your computer, including Windows 
system memory and other memory not allocated to Windows.



Windows System Resources:    Windows reserves a portion of memory for its own operation; this 
portion is referred to as Windows System Resources.    The two key components of System Resources, 
GDI (Graphics Device Interface) memory and User memory, each reserve 64K of memory. Windows uses
GDI memory for graphics operations, such as butmaps, lines, and fill patterns.    Windows uses USER 
memory for the remainder of its features, such as text, menus, and window frames.

Every Windows application you open uses up some of the System Resources' GDI and User memory.    If 
you have too many applications open, the available level of System Resources becomes too low to 
launch any new Windows applications.    If you are unable to launch a new application, or the Resource 
Gauge indicates that your System Resources are too low for the application you want to launch, you can 
increase the level of available System Resources by closing one or more of your currently running 
applications.



Working Directory:    When you want to work with data files in a different directory than the proram you 
use to create those files, you specify a Working Directory in the Customize dialog box.    When you launch
the program, the current directory will be the working directory.    Here's an example:    Your word 
processing program, WinWord, is in a directory named WORD, but you've specified a working directory 
named MEMOS. When you run WinWord and use the Open command, you'll see MEMOS displayed as 
the working directory in the Open File dialog box.





attrib Displays or sets the attributes (read-only, archive, system, hidden) of files.

attrib [+r|-r] [+a|-a] [+s|-s] [+h|-h ] [[drive:][path]filename] [/s]



call Transfers control from one batch file to another until that batch file ends, returning control to the 
first batch file.

call [drive:][path]filename [batch-parameters]



cd (chdir) Changes the directory or displays the name of the current directory.

cd [drive:] [path]
cd[..]

chdir [drive:] [path]
chdir[..]



cls Clears the screen and the command line, as well as removing all previous output from the output 
window.

cls



copy Copies a file from one location to another or combines files.

copy [/a|/b] source [/a|/b] [+source[/a|/b] [+ ...]] [destination [/a |/b]] [/v]



date Changes the system date.

date [month-day-year]



del (erase) Erases a file or group of files.

del [drive:] [path] filename [/p] [/s]
erase [drive:] [path] filename [/p] [/s]



dir Lists the files and subdirectories in a directory.

dir [drive:] [path] [filename] [/p] [/w] [/a[[:]attributes]] [/o[[:]sortorder]] [/s] [/b] [/l]



echo Determines whether commands are displayed as they are executed from the command prompt or
from a batch file.

echo [off|on]
echo [message]



edit Opens the specified text file in the Windows Notepad application.

edit [[drive:][path]filename] 



find Searches for a string of characters or numbers within a specified file or files.

find [/v] [/c] [/n] [/i] "string" [[drive:][path]filename]



for Allows you to perform a command on a set of files.

When used in a batch file:
for %%variable in set do command [command-parameters]

When used at the command prompt:
for %variable in set do command [command-parameters]



goto Transfers execution in a batch program to a specified line, rather than the next line in the batch 
program.

goto label



help Loads the help system.

help [<command name>]



if Tests whether a condition is true before carrying out a command. (If the condition is false, the 
specified command is not executed.)

if [not] errorlevel number command
if [not] string1==string2 command
if [not] exist filename command



label Displays or changes the volume label assigned to a floppy disk or hard drive.

label [drive:] [label]



md (mkdir) Creates a subdirectory on the specified drive.

md [drive:]path
mkdir [drive:]path



path Determines where to look for executable files (.EXE, .COM, .BAT, AND .PIF) and documents.

path
path [=] [[drive][path][;...]]



pause Suspends execution of a batch file until the user presses a key or clicks a mouse button.

pause



print Allows you to print a file to the current printer.

print [[drive:][path]filename[...]]



prompt Determines how the command prompt is displayed.

prompt [text]



rd (rmdir) Removes the directory specified by <dirname>.

rd [drive:][path]
rmdir [drive:][path]



rem Precedes comments in batch files.

rem [comment]



ren (rename) Renames files or directories.

ren [drive:][path] filename1|directoryname1 filename2|directoryname2
rename [drive:][path] filename1|directoryname1 filename2|directoryname2



set Displays, sets, or deletes DOS environment variables.

set [variable=[string]]



shift Allows a user to specify more than ten parameters on the command prompt for a batch file by 
replacing the contents of the first parameter (%0) with the contents of the second (%1) and 
shifting each subsequent parameter down in similar fashion.



sort Sorts input and writes the output to a device or file.

sort [/r] [/+n] [<] [drive1:][path1]filename1 [>[drive2:][path2]filename2]
[command|]sort [/r] [/+n] [>[drive2:][path2]filename2]



subst Assigns a drive letter to a directory.

subst [drive1: [drive2:]path]
subst drive1: /d



time Displays or sets the system time.

time [hh:mm]ss:[.xx]][a|p]]



type Displays the contents of an ASCII text file within the Windows Prompt Edit Control output 
windows.

type [drive:][path]filename



ver Displays the version of your operating system and the version of Windows Prompt Edit Control.

ver



vol Displays the label and serial number assigned to a drive.    If no drive is specified, the current 
drive is used.

vol [drive:]



xcopy Copies files, using all memory made available by Microsoft Windows.

xcopy source [destination] [/a|/m] [/d:date] [/p] [/s [/e]] [/w]



exit Closes the Dashboard Run dialog box.




